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Introduction 

List Plus gives you everything you need to create and 
organize lists, and to manage and make use of the 
information they contain. You can use List Plus to create 
something as simple as an address book or something as 
complex as a system to schedule and keep track of every 
room in a school or community center, the time and dates 
of every activity there, and the name, address, and phone 
number of the person who's responsible for each activity. 

List Plus has special features that let you easily handle 
specific kinds of information - such as text, numbers, 
money, dates, times, and phone numbers. And it lets you do 
much more than just store information. You can create 
formulas that let you work with information in over 30 
functionally different ways (and you can, of course, 
combine different functions in the same formula to create a 
practically limitless number of ways to manipulate 
information). The functions that are available extend from 
simple arithmetic operations like addition and subtraction to 
the arcane functions of Boolean algebra. You can do such 
things as generate random numbers, transform dates into a 
form that lets you use them in arithmetic formulas, create 
formulas that let you manipulate text, and develop If/Then 
equations. The result is that you can not only use List Plus 
to store information, you can actually create new 
information that brings out hidden relationships in the 
information you've stored in a list. 

List Plus gives you a wide selection of ways to arrange the 
information in a list and to extract important information 
that might not be obvious from looking at an entire list. 

1 



List Plus 

There are a dozen separate ways to match information to 
extract just the information you need. You can also combine 
the separate criteria for matching information to perform 
subtle analyses of the contents of a list. If you find a 
particularly useful set of information, you can create a new 
list to store the information in without affecting the original 
list in any way. You can also create new lists from old ones 
by transferring entire categories of information from one list 
to another. 

List Plus lets you create up to five different ways you can 
display or print the same information, and it lets you keep 
all five different formats immediately at hand. You can 
switch from anyone to any of the others in a single step. 
You never have to be locked into viewing the same 
information in a single way. You can use the different 
formats to print custom reports to tell you at a glance 
exactly what you need to know or to convince someone else 
of something only a subtle analysis of the information can 
demonstrate. 

If you own Writer's Choice elite or another word processor 
that works with the Apple lIos, List Plus lets you save lists 
in a special format that will let you integrate a report you've 
created directly with a document you've used a word 
processor to write. 

How to Use this Guide 

This guide has three sections. 

"A Guided Tour of List Plus" takes you through all the 
basic features of List Plus. It makes many stops along the 
way to let you experiment with the program and become 
familiar with how it works. 
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Introduction 

The "Reference" section covers every aspect of List Plus. It's 
the place to find anything that isn't covered in the guided 
tour. The "Reference" section is organized by the way 
things appear on the screen: the menu functions are listed 
according to which menu they appear on. 

The "Glossary" lists and defines special terms used in the 
guide that you may not know. 

What You'll Need 

• An Apple Hos with at least 512K RAM, with 2.0 ROM 
installed. 

• At least one 3 I12-inch disk drive. 

• A blank disk. It's always best to save the lists you create 
on a disk other than the List Plus program disk. 

• A printer, if you want to make printed copies of the lists 
you create. 

Making a Backup Copy of List Plus 

Your List Plus disk is not copy-protected, so you can make 
a fully workable backup copy for your personal use only or 
to install it on a hard disk. 

Store your original program disk in a safe place and use the 
backup copy for everyday use; that way, you won't risk 
damaging your original. And remember, you must be a 
registered owner to be eligible for support and program 
updates. 

You can use either the Finder or the system utilities on the 
Apple Hos System Disk. 
-----------------------------3 
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Using the Finder 

To back up List Plus on a floppy disk: 

1. Turn on your computer if it isn't already on. 

After a few moments, the Finder appears on the screen. 

2. If you have two disk drives, put the List Plus program 
disk in one drive and a blank disk in the other. 

If you have a single disk drive, eject the disk that's there 
if there is one, and replace it with a blank disk. ' 

3. If the blank disk you're using isn't initalized, a message 
box appears that asks you if you want to initalize it. 
Click the Initialize button. A dialog box appears that asks 
you to name the disk. Type List, then click OK. 

When the disk is initalized, an icon representing the disk 
appears on the desktop. 

4. If you have a single drive, eject the initialized disk and 
replace it with the List Plus program disk. The disk's icon 
remains on the desktop, but it's dimmed. 

5. Point to the icon of the program disk, hold down the 
mouse button, and drag the outline of the disk to the 
dimmed icon of the initialized disk. Release the mouse 
button. 

A dialog box appears that asks if you want to completely 
replace the contents of the initalized disk. 

6. Click OK. 
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Introduction 

If you have a single drive, the Finder prompts you to switch 
disks. 

A message box appears that tells you how many blocks 
remain to be copied. The process takes a little over a minute 
(it takes longer if you have a single drive). 

To back up List Plus on a hard disk: 

1. Turn on the computer if it isn't already on. 

After a few moments, the Finder appears on the screen. 

2. Put the List Plus program disk in the disk drive. 

3. Double-click on both the hard disk icon and the List Plus 
icon to open both of them. 

4. Move the pointer to the upper left corner of the List Plus 
icon, hold down the mouse button, and drag down and 
to the right to draw a selection box around all of the 
icons in the window. Release the mouse button. 

All the icons are selected. 

5. Point to the group of icons, drag them to the hard disk 
window, and release the mouse button. 

All of the files are then copied to the hard disk . 

Using the Apple IIGS System Utilities 

To back up List Plus on another floppy disk, you'll need the 
Apple IIGS System Disk. 
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1. From the files on the System Disk, select SYS. UTILS, then 
SYSUTIL.SYSTEM. 

2. F~om the listing Work on Entire Disks, select Duplicate a 
Disk. 

3. At the prompt Where is your source disk?, enter the slot 
and dnve for your original List Plus disk. The slot 
number will be 5. If you have one drive the drive 
number will be 1. If you have two drive~ the drive 
number will be 1 or 2, depending on whi~h drive you 
have your LISt Plus disk in. 

4. At the prompt Where is your destination disk?, enter the 
slot and dnve for the new disk that will be the backup 
copy. 

5. At the prompt Enter Name of New Volume, do not make 
any changes; you must use the default name of ILlstPlus/. 

6. The program will now format the new disk and make a 
copy of List Plus. 

To install List Plus on a hard disk, you'll need the Apple 
lIos System Disk. 

1. From the System Disk, select SYS.UTILS then SYSUTIL 
SYSTEM. ,. 

2. Under Work on Individual Files, select Copy Files. 

3. At.the prompt Where is your source disk? select Slot and 
Drive, . then enter the slot and drive for your original List 
Plz:s disk. T~e slot number will be 5. If you have one 
dnve, the dnve number will be 1. If you have two drives, 
th~ dnve number will be 1 or 2, depending on which 
dnve you have your List Plus disk in. 

6--------______ ~~ ______ _ 
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4. At the prompt Where is your destination disk?, select Slot 
and Drive, then enter the slot number and drive number 
of your hard drive. This information can be found in the 
installation manual for your hard drive. 

5. At Select some or all files on this disk, select All. 

The program will now copy List Plus onto your hard drive. 

Using the Mouse 

This guide uses four terms to designate the different ways 
you can use the mouse. Here's what the terms mean: 

Click means position the pointer and then press and quickly 
release the button on the mouse. 

Double-click means position the pointer and then press and 
quickly release the mouse button twice. 

Drag means position the pointer and hold the mouse button 
down while you move the mouse. You release the mouse 
button to choose a menu item or to select information. 

Press means position the pointer and then hold down the 
mouse button without moving the mouse. 

The Command Key 

Throughout this guide, keys are referred to by the name 
printed on them. This key 

is called the command key. __ _____________________________ 1 
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A Note on Type Styles 

In this guide, boldface type is used for words and messages 
that appear on the screen. Boldface is also used for words 
you're supposed to type or keys you're supposed to press. 
For example, 

Press delete 

means that you're to press the key that has the word delete 
printed on it. 

Sample Lists 

You'll find the following sample files on the List Plus disk. 
The sample files are for use with the examples in the 
"Guided Tour." 

Addresses 
AddressBook 
Cookies 
Library 
Realestate! 

Realestate2 
Schedule! 
Terms 
Translators 

A Note to the Adventuresome 

If you'd prefer to explore List Plus on your own instead of 
working through the guided tour in the first six chapters, 
there's no reason not to. List Plus is simple and 
straightforward and works the way you'd expect it to. 

You'll find in the "Reference" section (pages 99-183) an 
explanation of every item in every menu - just in case you 
need help. 
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A Guided Tour 
of List Plus 

Chapter 1 

Getting Started 
Starting List Plus with the Launcher 

You can start List Plus using either the launcher or the 
Finder. 

Note: Terms that appear in italics are explained in the 
glossary. 

There are two ways to start List Plus with the launcher. The 
method you use depends on whether your computer is off or 
whether it's on and the launcher is on the screen. 

Note: If you've set aside memory for a RAMdisk, any list 
you create has less space for information than without the 
RAMdisk. You can see how much memory is available by 
choosing About from the Apple menu. 

If the computer is off: 

1. If you have a printer, be sure it's off. 

2. Turn on the monitor - but not the computer. 

3. Put the List Plus disk in the disk drive with the label side 
up. 

_____________________________ 9 
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4. Turn on the computer (and your printer, if you have 
one.) The launcher loads into the computer. After a few 
moments, the launcher appears on the screen. It looks 
like this: 

Select the file you want to open: 
FcJ lUst Plusl 

Ust ~ ( Disk ) 
Prodos 
Samples 
Icons [ Open )) 
System 

( Close ) 

~ ( Cancel ) 

5. Find List on the list. If you don't see it, use the mouse to 
position the tip of the pointer (the black arrow) on the 
down arrow (at the bottom right of the list). Click the 
mouse button to scroll the list up until you find List. 

6. Position the tip of the pointer on List and click the 
mouse button. List is highlighted (it changes from black 
on white to white on black). 

7. Position the pointer on the Open button and click 
the mouse button. List Plus starts loading into the 
computer. 

After a minute or two, the title screen appears and then the 
desktop. 

The screen should look like the illustration on page 15. 
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Getting Started 

If the launcher is on the screen: 

1. The screen looks something like this: 

Select the file you want to open: 
FcJ lUst Plusl 

List ~ ( Disk ) 
Prod os 
Samples 
Icons r;: Open l) 
System 

( Close ) 

l- e Cancel 
, 

.(} ) 

2. If the List Plus disk isn't in the drive, eject the disk that's 
there and replace it with the List Plus disk, label side up. 
Then position the pointer on the Disk button and click 
the mouse button. In a moment, a new list of names 
appears on the screen. 

Note: Don't eject a disk when the disk drive is running. 
Wait until the drive stops, then eject the disk. 

3. Find List on the list. If you don't see it, use the mouse to 
position the tip of the pointer (the black arrow) on the 
down arrow (at the bottom right of the list). Click the 
mouse button to scroll the list up until you find List. 

4. Position the tip of the pointer on List and click the 
mouse button. List is highlighted (it changes from black 
on white to white on black). 

11 
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5. Position the pointer on the Open button and click the 
mouse button. List Plus starts loading into the computer. 

After a minute or two, the title screen appears and then the 
desktop. 

The screen should look like the illustration on page 15. 

Starting List Plus with the Finder 

There are two ways to start List Plus with the Finder. The 
method you use depends on whether your computer is off or 
whether it's on and the Finder is on the screen. 

Note: If you've set aside memory for a RAMdisk, any list 
you create has less space for infomation than without the 
RAMdisk. You can see how much memory is available by 
choosing About from the Apple menu. 

If the computer is off: 

I. If you have a printer, be sure it's off. 

2. Turn on the monitor - but not the computer. 

3. Put the List Plus disk in the disk drive with the label side 
up. 

4. Turn on the computer (and your printer, if you have 
one). The Finder loads into the computer. After a few 
moments, the Finder appears on the screen. It looks like 
this: 

u--------------__________ ___ 
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Getting Started 

5. Find the icon with the word LIST beneath it. If you don't 
see it, use the mouse to position the tip of the pointer 
(the black arrow) on the right arrow (at the bottom of the 
window). Click the mouse button to scroll the contents of 
the window to the left until you find the LIST icon. If 
'you can't find the LIST icon there, point to the left arrow 
and click the mouse button to scroll the contents of the 
window to the right. 

6. Position the tip of the pointer on the LIST icon and 
double-click the mouse button. The LIST icon is 
highlighted (it changes from black on white to white 
on black). List Plus starts loading into the computer. 

After a minute or two, the title screen appears and then the 
desktop. 

The screen should look like the illustration on page 15. 

_______________________________ D 
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If the Finder is on the screen: 

I. The screen looks something like this: 

2. If the List Plus disk isn't in the drive, eject the disk that's 
there and replace it with the List Plus disk, label side up. 

Note: Don't eject a disk when the disk drive is running. 
Wait until the drive stops, then eject the disk. 

An icon representing the disk appears on the desktop. 

3. Position the pointer on the disk icon and double-click the 
mouse button. In a moment, a new window appears 
containing an icon for each of the files on the List Plus 
disk. 

4. Find the icon with the word LIST beneath it. If you don't 
see it, use the mouse to position the tip of the pointer 
(the black arrow) on the right arrow (at the bottom of the 
window). Click the mouse button to scroll the contents of 
the window to the left until you find the LIST icon. If 
you can't find the LIST icon there, point to the left arrow 
and click the mouse button to scroll the contents of the 
window to the right. 

w--------------__________________ ___ 
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Getting Started 

5. Position the tip of the pointer on the LIST icon and 
double-click the mouse button. The UST icon is 
highlighted (it changes from black on white to white 
on black). 

After a minute or two, the title screen appears and then the 
desktop. 

The screen should look like this: 

List Plus is now ready for you to use. 

The Desktop 

List Plus's desktop holds just about everything you need to 
create any kind of list you can imagine. (In this guide, list 
means any kind of document that's made up of rows and 
columns - an address list, a class schedule, a spreadsheet, 
and so on.) The tools you need to create a list, to edit it, 
arrange the way it looks, and print reports based on the 
information in it are contained in the menus. You can 
display each menu by pointing to its name on the menu bar, 
then pressing and holding down the mouse button. 

------------------------------~ 



List Plus 

The Menu Bar 

Look at the top line on the screen. It looks like this: 

oj File [,jit Fields F:ecords Calculate Sort Reports 

The menu bar contains the eight menus you can choose 
from when you're using List Plus. To see the commands 
each of the menus contains, point to the name of each menu 
in turn and hold down the mouse button. 

The Apple menu (represented by the picture of an apple) 
displays a clock with the current time and gives you 
information about the version of List Plus you're using. See 
the "Reference" section for more information about it. 

The File menu contains the commands, such as Save and 
Print, that apply to an entire list. You'll find explanations of 
the most important commands on the File menu later in this 
chapter, and in Chapter 2, "Making and Using a List," and 
Chapter 3, "Designing a List." 

The Edit menu contains commands you use to work with 
single cells and with rows of information. Chapter 2, 
"Making and Using a List," and Chapter 3, "Designing a 
List," explain how to use those commands. 

The Fields menu contains the commands that you use to 
work with columns of information. You'll find out how to 
use those commands in Chapter 3, "Designing a List." 
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Getting Started 

The Records menu contains the commands you use to select 
records from a list and to arrange the way you want records 
to appear on the screen. Chapter 5, "Manipulating a List," 
explains how to use them. 

The Calculate menu contains the commands you use to 
perform calculations on the information in columns. Those 
commands are covered in Chapter 4, "Using Calculations 
and Formulas." 

The Sort menu contains the two commands you use to 
arrange all the records in a list in order. Chapter 5, 
"Manipulating a List," explains how to use them. 

The Reports menu contains the commands you use to create 
and print a report based on the information in a list. All 
those commands are explained in Chapter 6, "Printing a 
Report." 

Windows and Boxes 

When you're using List Plus, you'll see three different types 
of elements on the screen: windows, dialog boxes, and 
message boxes. 

Windows. Windows are areas you use to enter, organize, 
and sort the information in a list. Along with the list 
window, there's also the data entry window. 
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The data entry window is where you enter information you 
want to add to a list and where you edit information that's 
already part of the list. (If you're displaying each record in 
the list window as a separate form, the data entry window 
disappears because you can type information and edit it 
directly on the form itself.) 

List Window 

'0 Untitled_DO E'], 

" 8 C 0 E F 0 

() 

{) 
,~ o\'] 

Data Entry Window 

You can have up to four list windows open at once, and you 
can use whichever one you want at any time. That's not true 
of dialog boxes and message boxes. When a message box is 
on the screen, you have to respond to it before you can do 
anything else. 

Dialog boxes. A dialog box appears when List Plus needs 
specific instructions about a task you've given it before it 
can carry out the task. For example, you can use a dialog 
box to name a list you're about to have List Plus save; you 
can also use a dialog box when you want to select part of a 
list, to identify for List Plus which records you want it to 
select. 
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~ IList Plusl 
39K free on BOOK ( Next Drive ) 
o System it 
$u List 

( NeY! Folder ) 

o Gslisttools ( Open ) o Samples 
o Icons r f1')S;) ) 

,iJ.. 
Sa'".'e Rs: ~ Save ~ 

I ( Cancel ) 

@ List Plus Form at 

o ASCII Format 

Message boxes. A message box appears when List Plus has 
information about the task it's carrying out. For example, it 
might display a message to tell you the disk you wan~ to . 
save a document on is full, that none of the records III a list 
match the selection criteria you've specified, or that the 
syntax of a formula you've created is ·incorrect. 

Syntax error 
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The List Window 

The list window is the part of the screen where the list 
you're working with appears. 

Close Box Full Size Box 
\ I Title Bar Form BO~ 

"-
~ tTntitled,OO m 

A B C 0 E F 
D 

D 
0 - 0 

~ 
Scroll Bars Change Size Box 

Whenever you start List Plus, an empty list window appears 
on the screen. You can either start a new list in the empty 
window or open another window that contains a list you've 
already created. You can have up to four lists open on the 
screen at the same time. 

You can manipulate a list window in several ways. You can 
change its size, move it to a different part of the screen, 
move it behind or in front of other windows that are on the 
screen, and close it. You can also move a list under the list 
window to display parts of the list that are hidden. 

You use the horizontal scroll bar to move a list left or right 
in the list window. You use the vertical scroll bar to move a 
list up or down in the list window. To use the scroll bars, 
you point to the scroll box, hold down the mouse button, 
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Getting Started 

and move the box in the direction you want the document 
to move; or you point to an arrow and click the mouse 
button. 

The close box lets you remove a list from the screen. To use 
the close box, you point to the close box and click the 
mouse button (be sure to save the list first if you want to 
keep it). 

You use the full size box to expand a list window to fill the 
entire area on the desktop under the data entry window; you 
also use it to return an expanded list window to its original 
size. To expand or shrink a list window, you point to the 
full size box and click the mouse button. 

You use the form box to switch between displaying the list 
in the row-and-column format and displaying the list one 
record at a time with each record on a separate form. To 
switch between forms and the row-and-column format, you 
point to the form box and click the mouse button. 

When you display each record on a separate form, the data 
entry window automatically disappears until you switch back 
to the row-and-column format. 

The function of the scroll bars also changes when you 
display each record on a separate form. The horizontal 
scroll bar lets you move from record to record, while the 
vertical scroll bar lets you move from the top to the bottom 
of a single form. 

The change size box lets you make a list window any size 
you want it to be. To change the size of a window, you 
point to the change size box, press the mouse button, and 
hold it down. An outline appears around the list window. 
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You drag the outline of the window until it's the size you 
want, then release the mouse button. The list window is 
redrawn in the size the outline indicates. 

The Keyboard 

The keyboard of the Apple Hos has all the keys that are 
standard on computer keyboards plus a few that are unique 
to the keyboards of Apple computers. The following keys 
have important functions in List Plus: 

• return 
• shift 
• delete 
• tab 
• caps lock 
• option 
• command 

The option and command keys and the placement of the 
arrow keys are unique to Apple computers. Make sure you 
know where they're located. 

The special uses that keys have in List Plus are explained 
throughout this guide. If you need information about the 
usual way that any of the keys function, check the glossary 
at the back of this guide or "The Mouse and the Keyboard" 
in the Apple Hos owner's guide. 

Quitting List Plus 

If you want to quit List Plus at any time, first save the list 
you're working on (see "Saving a List" in Chapter 2, "Making 
and Using a List"), then choose Qmt from the File menu. 
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Chapter 2 

Making and Using a List 

This chapter explains how to enter information in a list, 
how to edit and sort the information, and how to print the 
list. The design of the list that you'll be working with in this 
chapter has been taken care of so you can get started right 
away (you'll find out how to design a list yourself in 
Chapter 3). The design is stored in an empty list on the List 
Plus program disk. 

If you quit List Plus at the end of Chapter I, restart it. 

Opening a List 

To get a list that's saved on a disk, you open the list. 
Choose Open from the File menu: point to File on the menu 
bar, hold down the mouse button, drag the pointer down 
until Open is highlighted, then release the mouse button. 
The Open dialog box appears. 

In the left half of the box is a list of the names of the lists 
and other files on the disk. The list of names is called a 
catalog. If a catalog has more names on it than can fit in 
the window, you can scroll the list up and down to see all 
the names. 
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Choose Samples from the list and click Open. Another 
catalog appears. Samples isn't a list or a file, it's a folder 
that contains all the sample lists on the List Plus program 
disk. Notice that the name Samples has been added to the 
line of text next to the disk icon at the top of the dialog 
box. 

Choose Addresses from the list and click Open. The dialog 
box disappears, the wristwatch icon replaces the pointer for 
a moment, then an empty address list appears on the screen. 
It looks like this: 

Notice that Addresses hasn't erased the list window , 
U ntitled.OO, that appeared automatically when you started 
List Plus. Untitled.OO is still on the desktop, but it's behind 
Addresses. You can still see its title bar above Addresses'. To 
see more of Untitied.OO, point to Addresses' title bar and 
hold down the mouse button. An outline appears around 
the Addresses list window. Drag the outline down. Release 
the mouse button. The desktop is redrawn with part of 
Untitled.OO showing above the top of Addresses. 
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Making and Using a List 

Cells, Rows, and Columns 

Every list is constructed out of three basic units: cells, rows, 
and columns. 

Column Row 

A row runs across a list, a column runs up and down. At a 
place where a row and column cross, they form a cell. A cell 
is a box where you can put information. 

Selecting Cells, Rows, and Columns 

Before you can work with a cell, a TOW, or a column, you 
have to select it. 

Selecting a Cell 

To select a cell, you point to it and click the mouse button. 
When a cell is selected, it's black. The first cell in an empty 
list is automatically selected when it appears. 
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Try selecting another cell: point to another cell in the same 
row and click the mouse button. When you do, the cell 
turns black to indicate that it's selected. 

Selecting Rows and Columns 

Selecting any cell in a column also selects the entire column. 
Selecting any cell in a row selects the entire row. The 
appearance of a column or row doesn't change when it's 
selected; a column or row is shown to be selected just by the 
selected cell within it. 

Try selecting a cell in any of the rows below the first one, 
and you'll find out that you can't. You can't select any cell 
that has gray borders because it's inactive. Only cells with 
black borders are active. 

Activating a Row 

To activate the next row in a list, you select any cell in the 
last active row, then press return. Once you've activated a 
row, it stays active until you delete it (Chapter 3, "Designing 
a List," explains how to delete both rows and columns). 

Activate the second row in Addresses: press return. 

When you activate a row, a black border appears around 
every cell in it. You can't activate just part of a row. 
Activating a row means activating every cell in every active 
column in the row. 

Entering Information 

To enter information in a list, you first select the cell where 
you want the information to appear. 
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Making and Using a List 

To enter information in a cell, you select the cell, then type 
the information you want to appear in the cell. To make the 
change final, you press tab. The information in the data 
entry window is then displayed in the cell you selected, and 
the next cell to the right is automatically selected. (If the cell 
you entered the information in was in the rightmost column, 
the cell in the leftmost column is automatically selected.) 

Select the first cell in the first row again. You'll notice that 
the heading for the column is Phone. Type this number: 

512 555 7093 

As you type the number, it appears in the data entry 
window rather than in the cell you've selected. If you make 
a mistake, press delete to back up and erase it, then retype 
the number correctly. When you've finished, press tab. 

The phone number appears in the cell you selected. Take a 
look at the number. List Plus hasn't displayed it exactly as 
you typed it: List Plus has added parentheses around the 
three digits of the area code and put hyphens between the 
three sets of number. You can have List Plus automatically 
display numbers in a variety of ways: as phone numbers, 
dates, times, and so on (see "Setting Data Display 
Attributes," in Chapter 3.). 

There are three alternatives to pressing tab to enter 
information in a cell: 

• You can click the OK button instead. If you click OK, the 
information you've entered is displayed in the cell you 
selected, and the cell remains selected. 
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• You can press return. When you press return, List Plus 
automatically selects the first cell in the row below the one 
where you were working. If the row below the one where 
you're working isn't active, List Plus activates it. 

• You can point to any other cell and click the mouse button. 
When you do that, the information you've entered is 
displayed in the cell you selected beforehand, then the cell 
you're currently pointing to is selected. 

Try these other techniques: 

First, select the cell under Last Name in the first row, if it 
isn't selected. Type Hartz, then point to OK and click the 
mouse button. 

Hartz appears in the cell, and the cell remains selected. 

Next, press the right arrow key. 

The cell in the First Name column is selected. 

Type Don, then point to the cell to the right (under No.), 
and click the mouse button. 

Don appears in the cell in the First Name column, and the 
cell in the No. column is selected. 

Categories and Records 

You may have noticed by now that columns and rows serve 
different functions in a list. 

Columns represent categories: phone numbers go in the 
Phone column, street numbers go in the No. column; last 
names go in the Last Name column, and so on. 
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Rows, on the other hand, contain specific pieces of 
information that fit in each of the categories the columns 
represent: (512) 555-7093 is a specific phone number, and 
Hartz is a specific last name. Of course, the information 
that's in a single row all belongs together: the phone number 
(512) 555-7093 belongs to the person named Don Hartz. A 
row is also called a record because you use a row to record 
the information that belongs together. 

Editing Information 

You can edit the information in a cell by changing it (either 
by deleting part of it or by inserting text or numbers in 
what's already there), by replacing it with different 
information, or by erasing the information and leaving the 
cell empty. 

Changing Information 

To change the information in a cell, you select the cell to 
display the information that's currently there in the data 
entry window. You then point to the entry window where 
you want to make the change and click the mouse button 
to place the cursor - a blinking vertical line - there. To 
insert a character, you simply type it; the new character 
appears at the spot where you've positioned the cursor. To 
delete a character, you position the cursor to the right of it 
and press delete; the character is erased. 

Change the name Don to Dan: First point to the cell with 
Don in it, and click the mouse button to select the cell. Don 
appears in the data entry window. 
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Point to the space in between the letters 0 and n, and click 
the mouse button. The cursor appears between the two 
letters. 

Press delete to erase the letter 0, then type a. The letter 0 is 
replaced with a, and Don becomes Dan. 

Undoing a Change 

You can undo a change with the Undo command, but only 
before you make the change final by pressing return, 
clicking OK, or selecting another cell. (There are also other 
changes you can undo with Undo; they'll be pointed out as 
they come up.) 

To undo a change, just choose Undo from the Edit menu. 

Undo the change you've just made: change Dan back to 
Don. 
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Here's what to do: 

Point to Edit where it appears on the menu bar, and hold 
down the mouse button. The Edit menu appears. 

Keep holding down the mouse button, and as you do, move 
the pointer down the menu until Undo is highlighted. Then 
release the mouse button. Undo flickers, and almost 
immediately Dan changes back to Don. 

Since you've changed the information in the cell back to 
what it was originally, you don't have to make the change 
final. You can just go on to the next thing you want to do. 

Replacing Information 

You can completely replace information that's currently in a 
cell with other information in a single step. 

To replace information, you select the cell the information is 
in. When the information appears in the data entry window, 
you simply type the new information: The old information is 
completely erased as soon as you finish typing. 

Replace Hartz with a different last name: 

First select the cell Hartz appears in. When Hartz appears in 
the data entry window, type Hearts. Hartz is immediately 
replaced by Hearts as soon as you finish typing. 

Click OK to finalize the change. 
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Saving a List 

You can save a list any time you want. You need to save the 
information you've added to the list because the image of 
the list on the screen lasts only as long as the computer is 
on. If you turn off the computer without saving the list, 
you'll lose all the information it contains. When you save a 
list, it's stored on the ctisk in the disk drive; it also remains 
on the screen until you close the list window or quit. The 
copy stays on the disk until you erase or replace it (for 
information about erasing a list from a disk, see your system 
disk guide). You can always get the list back from the disk 
and display it on the screen again. 

It's a good idea to frequently save a list you're working on. 
That way, if the power goes out, you won't risk losing more 
than a little of your work. 

To save a list, you choose Save from the File menu. Or you 
can choose Save As if you want to give a list a new name 
when you save it (for example, you might want to keep the 
old version of a list you've just made changes to). The only 
difference between Save and Save As is that when you 
choose Save As, a dialog box appears that lets you give the 
list you're saving a new name. Save, on the other hand, 
saves the list automatically with the name it already has. If 
you're saving a list for the first time (the name in the title 
bar will be Untitled followed by a number), Save and Save 
As work exactly the same way. 
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Making and Using a List 

Give Addresses a new name, then save it. First, choose Save 
As from the File menu. This dialog box appears: 

Ii3l !List Plus! 
39 Klree on 800 K ( Next Dri'Je ) 
DSystem it ( NeY! Folder ) 
€OJ List 
D Gslisttools ( Open ) DSamples 
DIcons ( t:1 [;~;B ) 

,(J, 

Save Rs: ~ Save ~ 
I ( Cancel ) 

@ List Plus Form at 

o ASCII Format 

Look at the bottom of the dialog box. Addresses appears in 
the space below Save As. The name that appears there is 
always selected - as Addresses is - so that you can replace 
it just by typing a new name. But in'this case, you just want 
to change Addresses to Addressesl. 

Move the pointer to the right of the last s in Addresses, and 
click the mouse button. The cursor appears. Type 1. 

Notice the Cancel button in the lower right corner of the 
dialog box. You can't use Undo to 'unsave' a list once List 
Plus has started to save it (in fact, you can't undo any of 
the commands on the File menu once List Plus has started 
to carry out the command). Instead, you use the Cancel 
button to leave the dialog box without carrying out the Save 
As command. 
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List Plus takes up most of the space on the program disk, 
so it's best to save lists on a different disk. Before you save 
a list, first eject the List Plus disk from the drive and 
replace it with another initialized disk. Or if you have a 
second disk drive, put another disk in it. (If you need 
instructions on how to initialize a disk, see your Apple Has 
owner's guide.) 

To switch disks: 

If you have just one disk drive, make sure the Save As 
dialog box is on the screen, then press the button on the 
disk drive to eject the List Plus program disk, and replace it 
with an initialized disk. Point to the Disk button in the Save 
As dialog box, and click the mouse button. 

If you have a second disk drive, put a formatted disk in it 
and click the Disk button. 

In a moment, the catalog in the Save As dialog box lists the 
files on the disk (if there are any). 

To save Addressesl, click the Save button. The wristwatch 
icon replaces the pointer for a moment while List Plus saves 
the list. When the pointer reappe',m, you can continue 
working in the list window. 

Once you've saved a list with the name you want it to have, 
you can use Save rather than Save As. The Save command 
assumes that you want to replace the old version of a list 
with a new version. If you want to save different versions of 
a list, use Save As and give each version a different name. 
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Closing a List 

To remove a list from the screen, you close the list window. 
Closing the list window doesn't save the list that's there. If 
you want to keep the list, you have to save it first. 

You close the list window by choosing Close from the File 
menu. If more than one window is open on the screen, 
Close closes the one that's active (the active window is the 
one in front of all the others; four horizontal lines appear 
in its title bar). If you haven't made any changes to the list 
since you last saved it, the window closes immediately. 

But if you've changed the list in some way, the process is 
different. 

To find out how the process is different, add a street 
number to the first cell in the No. column: select the cell, 
type 471, and click OK. 

Now choose Close from the File menu. A dialog box 
appears that asks if you want to save the changes you've 
made. 

Do ~iOIj 'w'om to so 'Ie file: 

Rd,jresses 1 ? 

It Ves ~ 
( No ) ~ ( Concel ') 
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If you click No, the list window disappears from the 
desktop, and the changes aren't saved. 

If you click Cancel, the list window reappears just as it was 
before you clicked the close box. 

If you click Yes, the new version of the list is saved, and the 
list window disappears. 

Click Yes. 

After List Plus has saved Addressesl in its new form, 
choose Close again. The list window containing Addressesl 
disappears. 

Sorting a List 

One of the first things you usually do after you create a list 
is to organize it. Organizing the information in a list is 
called sorting. 

To sort a list, you first select the column you want List Plus 
to use as the basis for the organization. For example, for a 
list of addresses, you'd probably choose the last names of 
the people on the list. Then you select one of the sort 
options from the Sort menu. There are two options: Sort 
Up and Sort Down. Sort Up organizes information from 
first to last (for example, from A to Z) or from smallest to 
largest (for example, $1.00 to $99.00). Sort Down does the 
opposite: it sorts from last to first or from largest to 
smallest. (List Plus actually sorts the information in a 
column according to its ASCII value - unless the column is 
set up as currency, dates, or time - see "Sorting 
Information" in Chapter 5, "Manipulating a List," and the 
Appendix, "ASCII Values," for more information.) 
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Making and Using a List 

There's a list of a half dozen addresses and phone numbers 
on the program disk. It's named AddressBook. You can use 
it to see how sorting works. 

First open AddressBook: 

Choose Open from the File menu. When the dialog box 
appears, point to AddressBook and click the mouse button. 
Then point to the Open button in the dialog box and click 
the mouse button. In a moment, AddressBook appears on 
the screen. 

To sort the records alphabetically according to last names, 
first select any cell in the Last Name column. Then choose 
Sort Up from the Sort menu. In a moment, the list is 
sorted. 

Experiment if you'd like with sorting the list by the 
information in other columns, then save the list in its new 
form. (Remember that List Plus is actually sorting according 
to ASCII value; if the results of sorting the list aren't what 
you expect, check the Appendix.) 

Printing a List 

Once you've finished a list, you'll want to print a copy of it. 
But before you print for the first time, you have to let List 
Plus know what type of printer you have connected to your 
computer and which port the printer is connected to. 

Note: If you're using AppleTalk, see "Choose Printer" in the 
"Reference" section for important information. 
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Select Choose printer from the File menu. This dialog box 
appears: 

Choose Printer ',]1.3 

( Concel ) ( OK , 

If the Printer type and the Printer port selected match your 
system, click OK. If not, point to the correct printer and 
port and click the mouse button. When you've selected the 
printer and port you want, click OK. List Plus saves the 
selections that you've made on the program disk, so make 
sure the write notch on the disk is covered. 

To print a list, you choose Print QuickList from the Reports 
menu (Print is slightly different from Print QuickList; for 
more information, see "Print" in the "Reference" section). A 
dialog box like one of these appears: 
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The options in the dialog box differ depending on whether 
you're using an ImageWriter or a ~aser:Vriter. I: yo~ want 
detailed information about the optlOns m the Prmt dialog 
box see "Choose Printer" in the "Reference" section. , 

To print AddressBook, first make sure your printer is 
connected to the computer, turned on, and on line. Choose 
Print QuickList from the Reports menu. Leave an the. 
options displayed in the dialog box set ~s they are .. ClIck 
OK. AddressBook is printed, and the dialog box disappears 
from the screen. 
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Chapter 3 

Designing a List 

If you used Paintworks Plus, Writer's Choice elite, and 
Draw Plus, you know that they require almost no set up of 
any kind. You can start painting a picture, composing a 
document, or creating a drawing as soon as the program 
starts. That's also true of List Plus, but to a lesser extent. 
While you can use a list just as it is when it first appears on 
the screen, you can organize information much more 
thoroughly if you give the list itself structure. 

This chapter explains how to structure a list and how to 
arrange the way it looks on the screen. 

If you quit List Plus at the end of the last chapter, start it 
again. 

Creating a New List 

To create a new list, you use the New option on the File 
menu. 

In this chapter, you're going to create the kind of list you 
can use to schedule various activities going on at the same 
time in the spaces available. 

Start by creating a new list: choose New from the File 
menu. 

An empty list appears on the screen. 
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Naming a Column 

Notice that the columns on the new list are labeled A 
through F. To give a column a name, you fIrst point to the 
cell that contains the column's name and double-click the 
mouse button. The column's current name appears in the 
data entry window, where you can edit or change it just like 
any other Item of information. Once you've typed the name 
you want to give the column, you accept it and transfer it to 
the head of the column by clicking OK, pressing return, or 
selectmg another column. 

Name the first column (the one currently labeled A) Place: 

Point to the cell that A is in and double-click the mouse 
button. Notice that even though the cell itself doesn't turn 
black to show it's selected like a normal cell, A appears in 
the data entry window, and the text in the lower left corner 
of the data entry window changes to Columu name. The 
screen looks like this: 
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Point to the letter A displayed in the data entry window and 
double-click the mouse button. The letter is selected. You 
can erase and replace it at the same time just by typing the 
new heading for the column: type Place. Press return, and 
Place appears at the top of the first colunm. 

Follow the same steps to rename column B Class. Then, 
type 114 under Place, and Creative Writing under Class. 

Save the list, and name it Schedule. 

Changing the Width of a Column 

Creative Writing isn't completely visible in the Class colunm 
because the column isn't wide enough. To change the width 
of a colunm, you move the pointer to the cell that contains 
the column's name, then point to the line that separates the 
column from the column to its right. For example, to 
change the width of colunm A, you point to the line 
between column A and column B. 

I ~ I ~ I The pointer changes to a double-headed arrow 
that crosses a vertical line. 

If you want to make the column narrower, you hold down 
the mouse button and move the double-headed arrow to the 
left. If you want to make the column wider, you hold down 
the mouse button and move the double-headed arrow to the 
right. A dotted line appears to show you how wide the 
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column will be when you release the button. When you've 
indicated the width you want, you release the mouse button. 
The column and all the columns to the right of it are 
redrawn, and the column's name is centered. 

To make the Class column wide enough to accommodate 
Creative Writing, first move the pointer to the row that 
contains the column names, then point to the line between 
the Class column and column C. When the double-headed 
arrow appears, press the mouse button. A dotted line 
appears (or will appear as soon as you move the mouse). 
Keep holding down the mouse button, and move the 
double-headed arrow to the right until it's over the letter C 
in column C. Then release the mouse button. The Class 
column and all the columns to the right of it are redrawn. 

Setting Attributes 

List Plus lets you limit the kind of information that can be 
entered in a column, and it also lets you choose the format 
in which you want it displayed. For example, you can enter 
a date like this: 

September 14, 1987 

or like this: 

9/14/87 

The information in either format is the same, but if you 
choose the second format and limit the information that's 
entered to numbers, List Plus recognizes the information as 
a date. Since it recognizes the information as a date, it can 
also manipulate the information as a date rather than just a 
series of numbers. 
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Setting Entry Attributes 

"Setting entry attributes" means to select the kind or amount 
of information that List Plus will accept for a given column. 
There are four different kinds of information that List Plus 
recognizes: 

Alphanumeric. The letters A through Z (both upper­
and lowercase), the digits 0 through 9, punctuation 
marks, and symbols (such as the ampersand (&), the 
asterisk (*), and so on). Alphanumeric is the setting for 
every column unless you choose a different setting. 

Alphabetic. Only the letters A through Z (both upper­
and lowercase) and spaces. 

Numeric. Only numbers, the decimal point (.), the plus 
( +) and minus ( - ) signs, and spaces. 

Digits only. Only the digits 0 through 9. 

You might limit information to alphabetic characters if 
you wanted a column to be sorted strictly alphabetically 
(remember that numbers and symbols affect the order in 
which records are sorted). You'd want List Plus to screen 
out everything but numeric information for a column where 
you were recording amounts of money. And if you had a 
column you intended to use for dates, you'd want to limit 
information to digits only. 

To select the kind of information you want List Plus to 
accept for a column, you select the column, then choose Set 
data entry attibutes from the Fields menu. This dialog box 
appears: 
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Doto entry For: A 
o Rlphanum~ric o RIphobetic 

() r~umerio; o Di~its only 

Limit input $ir€ to· [!QJ Chtlracters 

o Fllrmula o Default value 

Field: A ( Hext ) ( PrB'.'icrIJS )( Put in tarmu]c ) 
opemtor: (!)OG00CD®® 
II ~ 

( Cancel ) (I, ole )1 

The four attributes you can choose from are in the upper 
half of the box. (You use the bottom half of the box to 
create formulas; see "Formulas" in Chapter 4, ''Using 
CalculatiOns and Formulas," for information.) 

To choose an attribute, you point to the button next to the 
one you want and click the mouse button. The dot that 
appears indicates that the attribute is chosen. Then you click 
OK. The dialog box disappears from the screen. 

Try this example: 

Column C is for the date that the course in the Class 
column starts. First, change the name of column C to From: 

Point to column C and double-click the mouse. Erase C 
from the data entry window and replace it with From then 
click OK. ' 

Choose Numeric as the data entry attribute: 

Choose Set data entry attributes from the Fields menu. 
When the dialog box appears, point to the button next to 
Numeric and click the mouse button. Then click OK. 
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When the list reappears on the desktop, try entering letters, 
symbols, and punctuation marks in the cell below From. 
List Plus won't recognize anything but numbers. 

Setting Data Display Attributes 

The display attribute that you select for a column 
determines the format the information in the column will 
appear in. It also determines if List Plus can manipulate the 
information in any special way. For example, even if you 
enter a date in numbers, List Plus won't treat the 
information as a date if you don't also select Date as the 
display attribute. 

To select a display attribute, you select a column, then 
choose Set data display attributes from the Fields menu . 
This dialog box appears: 

Data display For: 

@ AlptlofllJmeric 
o Rlphabetic 0 LO'I!ercase - 0 Uppercase 
o NUmeric 0 Inte~8r 0 Fixed [] Decimal ploce(s) 
o Date 0 Slashes 0 Dashes 0 Disploy century 
C' Phone 0 (H~n'J) I~H~I·~IN),lt·1 0 lJH~I·~ll~),I·NH),lrl 
o Time 0 HH:'II~ (R).UPJ.1) 0 HH:,ll·j (Z4 hours) 
o ~loney Symbol: D 
o Betore valua 0 Rtter value D Decimal ploce(S) 

@Leftjuslified o Right justified o Centered 

~OD 

You then point to the button next to the attribute you want 
and click the mouse button. You may also have to make 
some other, secondary choices. Finally, you click OK, and 
the dialog box disappears. 
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Choose Date as the display attribute for the From column, 
then add a date to it: 

Select the From column, then choose Set data display 
attributes from the Fields menu. When the dialog box 
appears, choose Date. Notice that Slashes and Right 
justified are automatically chosen. Slashes means that the 
numbers of the date are separated by slashes, like this: 
9/14/87. You can also choose Dashes (for example, 9-14-87) 
and to display the century (9-14-1987) if you want. When 
you've made the selections you want, click OK. The dialog 
box disappears. 

When the list reappears, select the cell just below the 
heading From, and type 91487. Don't add slashes or dashes; 
List Plus adds them automatically (in fact, List Plus won't 
recognize them if you type them). When you've finished, 
click OK, and the numbers appear in the cell formatted as a 
date. 

Duplicating Attributes 

If you're creating one or more columns that have the same 
attributes, you can duplicate the attributes you've given to 
the first of the columns and then transfer the attributes all 
at one time to any of the other columns. To make the 
transfer, you use the Duplicate column option on the Fields 
menu. (You can also use Duplicate column to copy all the 
information in a column to another column; see "Transferring 
Information Between Lists" in Chapter 5, "Manipulating a 
List.") 

To duplicate attributes, you first select the column whose 
attributes you want to duplicate, then choose Duplicate 
column from the Fields menu. This dialog box appears: 
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~ ( Previous ) ~ 

r~ote that trlis \llill erose all the data of the target column ! 

The name after Copy from column is the column whose 
attributes you're copying. The name after to column is the 
column you're copying the attributes to. When the dialog 
box first appears, the name after to column and the one 
after Copy from column are the same. To change the name 
after to column to the name of the column you want to 
copy the attributes to, you click either the Next button or 
the Previous button. Next displays the name of the column 
to the right of the one whose name is currently displayed. 
Previous displays the name of the column to the left of the 
one whose name is currently displayed. 

Notice that the check box next to Data only has an X in it. 
The X means that List Plus will copy only the information 
in the column, not its data entry and display attributes. To 
remove the X, you point to the check box and click the 
mouse button. (Since there's no information in the column 
yet, List Plus copies only the column's attributes when you 
remove the X from the check box.) Finally, click OK. 

The column to the right of From is also going to hold a 
date - the date when the course named in the Class column 
ends. Duplicate the From column on column D: 
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First, select the From column, then choose Duplicate 
column from the Field menu. When the dialog box appears 
click the Next button to change the name after to column t~ 
D. Point to the check box next to Data only, and click the 
mouse button to remove the X in it. Then click OK. 

Notice that the name of column D has changed to From. 
Change the name to To: 

Select the new From column, then point to the name From 
in it, and double-click the mouse button. From appears 
in the data entry window. Type To, then click OK. The 
heading of the new From column changes to To. 

Select the cell below To, and enter 121887. 

Before you go on to the next section, name and format 
columns E and F: 

Rename column E Instructor. Select column E, point to E 
in the heading cell, and double-click the mouse button. Type 
Instructor, and click OK. 

Format the Instructor column for a name. Choose Set data 
entry attributes from the Fields menu, select Alphabetic 
from the dialog box, then click OK. Then select Set data 
display attributes from the Fields menu, select Alphabetic 
from the dialog box, and click OK. 

Enter Snsan Munroe in the first cell of the column. Adjust 
the width of the column so that the entire name is visible. 

Repeat the same steps for column F: rename it Work 
Phone, then select Digits only for its data entry attribute 
and Phone for its data display attribute. 
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Designing a List 

Enter 206 555 6381. Adjust the width of the column so that 
the entire number is visible. 

Adding and Deleting Columns 

When a new list first appears on the desktop, it's made up 
of only six columns. When you need more columns, you can 
create more either by adding a column to the right of the 
last column or by inserting a column in between two that 
already exist. 

Adding a Column 

To add a column, you choose Add column from the Fields 
menu, then type a name for the column in the data entry 
window, and press return. You don't have to select a 
column or position the pointer first, because the column 
you add is always placed to the right of the list's rightmost 
column. 

Add a column to Schedule: choose Add column from the 
Fields menu. The cursor appears on the data entry line in 
the data entry window. Type Home Phone and press return. 
Home Phone appears in the new column's heading cell, and 
the cell is now ready to use. 

Format the new column the same way as Work Phone. For 
the first cell in the column, enter 206 359 5973. Adjust the 
width of the column. 

Inserting a Column 

If you want to add a new column somewhere other than 
next to the last column, you use the Insert column option. 
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Inserting a column is almost identical to adding a column 
except that you first have to show List Plus where you want 
the new column to be inserted. To do that, you select a 
column; List Plus then inserts the new column to the left of 
the column you've selected. 

Insert a column between the To and Instructor columns: 

First select the Instructor column, then choose Insert column 
~rom the Fields menu. The cursor appears on the data entry 
lme III the data entry window. Type At and press return. 
The new column appears. 

Format the At column for time: Choose Set data entry 
attributes from the Fields menu, select Digits only from the 
dIalog box, then click OK. Then select Set data display 
attributes from the Fields menu, select Time from the dialog 
box, and click OK. 

Enter 900 in the first cell in the column. 

Insert another column between At and Instructor and name 
it Until. Then format the Until column just like the At 
column. Enter 950 in the first cell. 

Add this information to the next row before you go on to 
the next section: 

Place: 027 
Class: Adv. Composition 
From: 91487 
To: 121887 
At: 1100 
Until: 1150 
Instructor: Susan Munroe 
Work Phone: 2065556381 
Home Phone: 2063595973 
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Deleting a Column 

To delete a column, all you have to do is to select the 
column, then choose Delete column from the Fields menu. 
This dialog box appears: 

Rbout to delete column: 

R 

( Cancel) [ OK ] 

The name of the column should be Work Phone. 

You click OK to have List Plus delete the column you've 
selected. Since you can't use Undo to bring the column back 
once it has been deleted, the dialog box also has a Cancel 
button you can use if you change your mind. 

Insert a column in Schedule so you have something to 
delete: choose Insert column from the Fields menu, then 
press return when the cursor appears on the data entry line. 
A column named Unnamed is inserted in the list. 

Delete the column. Select Unnamed if it isn't still selected. 
Choose Delete colnmn from the Fields menu. The dialog 
box appears. Notice that the name of the column, Unnamed, 
appears in the dialog box so that you don't delete the wrong 
column by mistake. Click OK. The dialog box disappears, 
and the colunm is deleted. 

---------------------------------53 



List Plus 

Moving a Column 

You can rearrange the order of the columns in a list by 
using the Move column command. 

To move a column, you first choose Move column from the 
Fields menu. 

El The pointer changes from an arrowhead to a little 
!i=ji:- truck, like the one at the left. You move the truck 

to the column you want to move and press the 
mouse button. Dotted lines appear over the left and right 
margins of the column. You keep holding the mouse button 
and move the truck icon to the place where you want the 
column to be moved (the dotted lines representing the 
columns move as as you move the truck). When you release 
the mouse button, List Plus places the column you're 
moving to the left of the column the truck is on. 

The Column You're Moving 

!! ~ / ,0 Uo e.1lO EJ, • B C 0 E f 0 
I 11 

Q> 

" 
{) 

QI'J 
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Designing a List 

It moves the column you're pointing to with the truck (and 
the columns to the right of it) to the right to make room for 
the column you're moving. 

When the list is redrawn, the truck changes back to the 
arrowhead. 

Move the At column in between the Class and From 
columns: 

First, choose Move column from the Helds menu. When the 
truck appears, move it to the At column, then press the 
mouse button. Keep holding down the mouse button, and 
move the truck to the From column. Then release the mouse 
button. 

Then List Plus redraws Schedule and places the At column 
in between the Class and From columns. 

Follow the same steps to move the Unill column in between 
the At and From columns. 
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Creating and Deleting Rows 

The simplest way to create a new row is to select a cell in 
the last row that's active, then press return or enter. If you 
press return, List Plus creates a new row and places the 
cursor in the first (leftmost) cell in the new row. If you press 
enter, List Plus creates a new row and places the cursor in 
the cell below the cell the cursor was in when you pressed 
enter. Pressing return is equivalent to using the Add columu 
function, because it always adds a row after the last row 
that currently exists. You can also insert a row between any 
two rows that exist and duplicate an entire row, including its 
contents. 

Inserting a Row 

To insert a row, you first have to show List Plus where you 
want the new row to be inserted. To do that, you select a 
row; List Plus then inserts the new row above the row 
you've selected. 

Insert a row between the two that now exist: select any cell 
in the second row, the choose Insert row from the Edit 
menu. A new row appears immediately. 

Duplicating a Row 

You may have noticed when you entered the information 
for the second record in Schedule that much of the 
information was the same as in the first record. You can 
save time when you need to create a record that duplicates 
much of the information in a record that already exists by 
just duplicating the existing record and editing it. 

56--------------------------------

L 

~.~ 

E~:.3 

E,~3 

E:;····3 

~.:3 

~,',',,'~ '~ 
L_ 

~i'~ 
~l~ 

~I"~ 
~i~ 
~i3 
~I'~ 
~i~ 
~l'~ 
~/r~ 

E;I.·~ 
~ .....•... D!I 

1-
E:i"~ 

~iD!l 

~i'~ 
~iiij 
I!i':""~ 
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Before you duplicate a record, you first have to insert a 
new row immediately after the row you want to duplicate -
otherwise the copy of the row will replace the information in 
the row after it. Then you choose Duplicate row from the 
Edit menu. All of the information in the record you selected 
is copied to the new row. 

Duplicate the first record in the row you just inserted: select 
any cell in the first row, then choose Duplicate row from the 
Edit menu. The information in the first record is duplicated 
in the empty, second row. 

Make these two changes to the information in the second 
row: change 9:00 to 10:00 in the At column, and 9:50 to 
10:50 in the Until column. 

Save Schedule when you've made the changes. 

Deleting a Row 

To delete a row, you select the row you want to delete, then 
choose Delete row from the Edit menu. No dialog box 
appears because you can use Undo to bring a row back if 
you delete it by mistake. 

First, insert a row so that you have one to delete: choose 
Insert row from the Edit menu. A blank row appears in the 
list. 

To delete the row, first select it if it isn't already selected, 
then choose Delete row from the Edit menu. The row 
disappears. 

Cutting, Copying, and Pasting Information 

You can use Cut, Copy, and Paste to move or copy 
information from one cell to another. 
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Cutting Information 

When you use Cut, you remove information from a cell 
and place it on the Clipboard. Information stays on the 
Clipboard, regardless of what changes you make to the list 
until you cut or copy something else. ' 

To use Cut, you first select the cell you want to cut 
information from. Then you choose Cut from the Edit 
menu. The information disappears immediately both from 
the data entry window and from the cell itself. 

You can also cut just part of the information in a cell. Say, 
for example, you want to cut just the first name from a cell 
that contains both a first and a last name. To do that, you 
first select the cell, and the name would appear in the data 
entry window. To select just the first name, you point to the 
space to the left of the first letter of the first name and press 
the mouse button. You then keep holding down the mouse 
button and drag the mouse to the right until the entire first 
name and the space after it are highlighted. Then you 
release the mouse button. Only the information highlighted 
is selected. You then choose Cut from the Edit menu. 
There's no apparent change to the information in the data 
entry window, but when you click OK, the information you 
cut disappears from the cell you selected. 

Cut the first name from a cell in Schedule: 

Select the cell in the first row in the Instructor column. 
Susan Munroe appears in the data entry window. Point to 
the space to the left of Susan and click the mouse button to 
display the cursor there. Then hold down the mouse button 
and drag the pointer to the left until Susan and the space to 
the right of it are highlighted. Release the mouse button. 
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Next, choose Cut from the Edit menu. The highlight 
disappears from Susan, but other than that, there's no 
apparent change. Click OK, and Susan is erased from the 
data entry window and the selected cell simultaneously. 

Copying Information 

When you use Copy, you make a copy of the information in 
a cell and place it on the Clipboard. Unlike Cut, Copy 
doesn't remove the information it's placing on the Clipboard. 
The information stays on the Clipboard, regardless of what 
changes you make to the list, until you cut or copy something 
else. 

To use Copy, you first select the cell you want to copy 
information from; if you want to copy just part of the 
information in a cell, you then select the part you want to 
copy. You then choose Copy from the Edit menu. List Plus 
makes a copy of the information and places it on the 
Clipboard. There's no change to the information in either 
the data entry window or in the cell you've selected, unless 
you've selected just part of the information in a cell. In that 
case, the highlight disappears from the information you've 
selected. 

Copy the name Susan in the second cell in the Instructor 
column: 

First, select the second cell in the Instructor column. Susan 
Munroe appears in the data entry window. Select Susan and 
the space after it (you can do so either by pointing to Susan 
and double-clicking the mouse button, or by using the 
technique you used in the previous section). Then choose 
Copy from the Edit menu. The highlighting disappears from 
Susan, and List Plus places a copy of the name on the 
Clipboard. 
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Pasting Information 

You can use Paste to transfer a copy of the information 
that's on the Clipboard to one of the cells in the list. The 
information that's on the Clipboard stays there even after 
you've copied it to a cell. Only cutting or copying different 
information erases the information that's currently on the 
Clipboard. 

To use Paste, you first select the cell you want to copy the 
information on the Clipboard to. Then you choose Paste 
from the Edit menu. The information in the cell is replaced 
with a copy of the information on the Clipboard. If you 
want to replace just a part of the information in the cell , 
you select the part you want to replace, then choose Paste. 
If you want to add the information on the Clipboard to the 
information already in the cell, you position the cursor in 
the text at the point where you want the new information to 
be inserted, then you choose Paste. 

Paste the copy of Susan that's currently on the Clipboard 
into the cell you erased it from earlier: 

First, select the first cell in the Instructor column. When 
Munroe appears in the data entry window, point to the 
space in front of Munroe and click the mouse button to 
position the cursor there. Choose Copy from the Edit menu. 
Finally, click OK. Susan appears in front of Munroe in both 
the data entry window and in the cell. 

Save Schedule before you go on to the next chapter. 
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~~~ Chapter 4 

Using Calculations 
~~and Formulas 

This chapter explains how to use List Plus's calculation 
functions and how to create formulas. 

The calculation functions are designed to work with the 
information in a column. You can total the values or count 
the number of items in a column, or find the average, the 
maximum, or the minimum value in a column. You can 
create formulas to perform standard arithmetic functions on 
the values in a row. 

If you quit List Plus at the end of the last chapter, restart it. 

Open the list named Cookies (open the Samples folder first 
if it isn't open already). Cookies was designed to keep track 
of how many boxes of cookies the children on the list 
ordered, sold, and returned. It also figures out the 
difference between the number of boxes ordered and the 
number either sold or returned. It has a column for 
recording the money that has been turned in and another 
column that automatically calculates how much money is 
still due. 

Calculations 

All of the calculation functions that are available are listed 
on the Calculate menu. You can use the Count function on 
a column regardless of the kind of information it contains. 
You can use the other four functions - Total, Minimum, 
Maximum, and Average - only on columns that have 
Numeric or Money as their data display attribute. 
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The Count Function 

The Count function tells you the number of entries you 
have in a column. The number of entries may not be the 
same as the number of records in the list. For example, if a 
record doesn't have an entry in the column you're counting, 
the blank entry isn't counted. 

To use Count, you select the column whose entries you want 
to count, then choose Count from the Calculate menu. The 
Calculate menu looks like this: 

List Plus counts the entries, then displays the number in a 
new row at the bottom of the list. (If you count more than 
one column, all the results are listed in the same row.) 
If the numbers of entries in a column changes, List Plus 
automatically updates the count. If you want to remove the 
count at the bottom of the column, choose Count again. 

Count the number of people who are listed on the Cookies 
list: select the Last Name column, then choose Count from 
the Calculate menu. 

Move down to the very bottom of the column and you'll see 
C 12 there. 
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Using Calculations and Formulas 

The Total Function 

The Total function adds together all the values in a column. 

To use Total, you select the column whose values you want 
to total and choose Total from the Calculate menu. 

Total the Ordered column: select the Ordered column, then 
choose Total from the Calculate menu. 

Move to the end of the Ordered column to see the total. 
Notice that a new row is added below the row that the 
count of the Last Name column appears in. That's because 
the row the count appears in is reserved for the counts of 
the other columns, whether you make them or not. The row 
that the total of the Ordered column appears on is, likewise, 
reserved for the totals of any of the other numeric columns. 

Total the Sold, Retnrned, and Money columns. 

The Minimum and Maximum Functions 

The Minimum function displays the lowest value in a 
column; the Maximum function displays the highest. 

To use either Minimum or Maximum, you select the column 
whose minimum or maximum value you want to see, then 
you choose either Minimum or Maximnm from the 
Calcnlate menu. 

Find the minimum and maximum values in the Ordered 
column. First, select Ordered, then choose Minimum from 
the Calculate menu. Notice that when the Calculate menu 
appears, there's a check mark next to Total. The check mark 
lets you know what functions you've already selected for a 
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column. Next, choose Maximum from the Calculate menu. 
Move down to the bottom of the list and you'll see that two 
new rows have been added, one for the minimum value and 
one for the maximum value. 

The Average Function 

The Average function displays the average of the values in 
the column. 

To use Average, you select the column whose values you 
want to average, then you choose Average from the 
Calculate menu. 

Find the average number of boxes sold and the average 
returned. First, select the Sold column, then choose Average 
from the Calculate menu. Then select Returned and choose 
Average from the Calculate menu again. 

Scroll to the end of the list and you'll see that another row 
has been added for the averages of the two columns. 

Formulas 

You can create a formula that uses addition, subtraction, 
division, and multiplication to derive a value from the other 
values in a single row. 

To create a formula, you first have to create a column where 
List Plus can display the results of the formula. Next, you 
select the new column you've created, then choose Set data 
entry attributes from the Fields menu. This dialog box 
appears: 
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Data Bntr~' F~r: R 

o Rlphonumeric o Rlphabetic 

C'r'JurilBric o Digits @l~i 

Limit input size to· Q!J characters 

o Forrnul'l o Default volue 

Field: R ~( Previous ) ( Put in formula ) 
OpePltor: (~)OG0I]CD@@ 
II I 

~ Ie OK ).1 

The lower half of the dialog box is where you create the 
formula. You click the button next to Formula, then you 
select the mathematical functions and the columns you w~nt 
to work with. You can also add numbers to the formula If 
you need to. When you're finished, you click OK. List Plus 
automatically calculates the results of the formula and puts 
the results in the column you've created. 

The Formula for the Difference Column 

The Difference column is for displaying the difference 
between the number of boxes each of the children ordered 
and the number each either sold or returned. Here's how to 
create the formula that calculates the difference and displays 
the result in the Difference column: 

First select the Difference column, then select Set data 
diS"I~Y attribntes from the Fields menu. The dialog bo~ 
appears. Choose Numeric from the dialog box, then click 
OK. 

When Cookies reappears on the desktop, select Set data 
entry attributes from the Fields menu. When the dialog box 
appears, point to the button next to Formula and click the 
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mouse button. All the elements in the lower half of the 
dialog box that were dimmed become functional. 

The formula you need to create has to first add the number 
of boxes sold to the number returned, and then subtract 
that sum from the number ordered. You use Sold, the name 
of the column in which the number of boxes sold is 
recorded, to stand for the number sold; Returned to stand 
for the uumber returned; and Ordered to stand for the 
number ordered. The formula will look like this: 

Ordered - (Sold + Returned) 

The parentheses around Sold and Returned tell List Plus 
to add the number sold to the number returned before 
subtracting the sum from the number ordered. 

Notice that the name next to Field gives the name of the 
column you're working with - in this case, Difference. 
Remember that Cookies looks like this: 

To create the formula, first click the Previous button three 
times: Click Previous once, and Returned replaces Difference. 
Click Previous again, and Sold replaces Returned. Click 
Previous a third time, and Ordered replaces Sold. The 
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function of the Previous button is to display next to Fie~d the 
name of the column to the left of the one whose name IS 
currently displayed there. 

Next, click Put in formula, which tells List Plus to display 
Ordered in the formula liue. Ordered appears m the formula 
liue enclosed iu square brackets, like this: [Ordered]: The~ 
click the minus sign button ( -). List Plus adds a mmus sIgn 
to the formula line. Click the left parenthesis button ( ( ). 
Up to this point, the formula looks like this: [Orderedl-(. 

Click the Next button to replace Ordered ~here it ap~ears 
next to Field with Sold. The Next button dIsplays beSIde 
Field the name of the column to the right of the one whose 
name is currently displayed there. Then click Pu~ in formula 
to add Sold to the formula line. Click the plus SIgn button 
( +). Then click the Next button again to display Returned 
next to Field. Click Put in formula to add Returned to the 
formula line, and finish the formula by clicking the r~ght . 
parenthesis button ( ) ). The finished formula looks hke thIS: 

10rderedl- ([Soldl + [Returned]). 

Click OK, and the dialog box will disappear. Whe.n the list 
reappears, the Difference column is immedIately filled m 
with the results of the formula for each row. 

The Formula for the Money Due Column 

Drag the horizontal scroll bar (at the bottom of the list 
window) to the right to display the Money due column. 

The Money due column first totals the uumber of ?oxes 
sold and the uumber in the Differeuce column. (which shows 
the number neither sold nor returned). It multIplIes the sum 
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by the price of each box of cookies ($2.95), then subtracts 
the money turned in from that total. The result is the money 
that's due. The formula looks like this: 

(([Sold] + [Difference])*2.95) -[Money in] 

Before you start to create the formula choose the data 
display attribute for Money due: selec; the Money due 
c?lumn, then choose Set data display attributes from the 
FIelds menu. When the dialog box appears choose Money 
then click OK. " 

When Co.okies reappears on the desktop, choose Set data 
entry attributes from the Fields menu. When the dialog box 
appears, choose Formula. 

St~t the .formula by clicking the left parenthesis button ( ( ) 
t';lce. ClIck the Previous button until Sold appears next to 
Field, then clIck Put in formula. Click the plus sign button 
( :-). ClIck the Next button until Difference appears next to 
Field, then clIc~ Put in formula. Click the right parenthesis 
button ( ) ). ClIck the multiplication sign button (*). Type 
2.95, :hen ~IIck the nght parenthesis button ( ) ) again. Click 
the mmus sign button ( -). Finally, click the Next button to 
display Money in next to Field, then click Put in fOrJlluia. 

The formula you've created should look like this: 

«([Sold] + [Difference])*2.95) - [Money in] . 

Click OK. When Cookies reappears, List Plus automatically 
fIlls m the results of the formula in the Money due column. 

Save Cookies before you go on to the next chapter. 
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Chapter 5 

Manipulating a List 

There are many ways you can arrange and rearrange a list 
to help you extract information from it or to make better 
use of it. This chapter explains how to sort and select 
information and how to transfer information between two 
lists. 

If you quit List Plus at the end of the last chapter, start it 
again. 

Open the list named Schedule1 (open the Samples folder 
first if it isn't open already). 

Sorting Information 

Most people, when they enter information into a list, don't 
enter it in any particular order. But it's much easier to use a 
list when it's organized in some obvious way. Sorting lets 
you arrange all the records according either to ASCII text 
value or to numerical value. . 

What determines whether information is sorted as text or as 
values is the data display attribute that you've chosen for the 
information. If you've chosen Alphanumeric or Alphabetic, 
the information is treated as text. If you've chosen Numeric, 
Date, Phone, Time, or Money, the information is treated as 
numerical values. Blank records are always last regardless of 
whether the information is treated as text or as numerical 
values. 
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ASCII Text Order 

ASCII is a standard for assigning numerical values to the 
letters of the alphabet, numbers, punctuation marks and 
symbols (you'll find a complete list of characters and their 
ASCII order in the Appendix). 

The ASCn order of the letters of the alphabet is the same as 
normal alphabetical order. 

Numbers and most symbols corne before the letters of the 
alphabet. Say, for example, you have a list of characters 
that looks like this: 

a*9?5zMO! 

If you ordered them according to their ASCII value the list 
looks like this: ' 

! * 0 59? a M z 

ASCII treats every digit in a number separately, just as it 
treats every letter in a word separately. For example, abacus 
doesn't corne after ant, even though it's a bigger word than 
ant, because b, the second letter in abacus, comes before n, 
the second letter in ant. In the same way, when 1213 and 19 
are ordered according to their ASCII values, 1213 comes 
before 19, even though it's a larger number, because 2 its 
second digit, comes before 9, the second digit in 19. The 
numerical value of a number doesn't matter; it's the ASCII 
value of each of its digits taken individually that determines 
where it belongs. 
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Sorting a List 

To sort a list, you first choose the column you want to use 
as the basis of the sort. List Plus will sort all of the records 
according to the information that's in the column you select; 
the information in the other columns has no effect on the 
sorting. Then you choose Sort Up or Sort Down from the 
Sort menu. The Sort menu looks like this: 

Sorting information up means that symbols and numbers 
will be at the top of the list and letters at the bottom, or 
that the smallest numbers will be at the top and the largest 
at the bottom. Sorting information down means the 
opposite: the letters of the alphabet will be at the top of the 
list and numbers and symbols at the bottom, or the largest 
numbers will be at the top and the smallest at the bottom. 

Try sorting Schedule! a few times using a differeut column 
each time. Use Sort Up and Sort Down to see how they 
differ. 
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Selecting Information 

Selecting lets you extract from a list just the information 
you need. For example, you can extract from Cookies the 
list you worked with in the last chapter, the records of only 
those children who still owe money or of those who have 
sold more than 20 boxes of cookies. You can extract from 
Schedule! all of the evening classes, or the records of all the 
classes taught by a single instructor, or the daily schedule 
for a particular room. 

The Select Function 

To select specific records from a list, you first select the 
column you want to use as the basis for the selection, then 
you choose Select from the Records menu. The Records 
menu looks like this: 

iCf---j--j FormZ 
P'-_-j--j Form3 
1/1 Form4 

Deline form 

Once you've chosen Select, this dialog box appears: 

R 

0pBl'otor : Equal to 
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You type the information you want to match in the entry 
box. Then you choose the operator you want to use - for 
example, you click the equal sign button (=) if you want to 
select only those records that match exactly the information 
in the entry box. (The function of the operator you pick is 
displayed next to Operator.) Then you click OK. List Plus 
goes through all the records in the list and hides all of them 
that don't match the information you want to select. You 
can save the short list of selected records as a separate list. 

You can display all of the records in a list again by choosing 
Select all from the Records menu. 

Relational Operators 

The operators that you can choose from in the Select dialog 
box are called relational operators because they let you 
compare two separate pieces of information. Unlike 
arithmetic operators (such as addition and subtraction), 
relational operators don't change either piece of information 
in any way. Their function is just to provide a way to 
compare information. 

This is what the operators mean: 

= is equal to 
< > is not equal to 
> is greater than 
< is lower than 

> = is greater than or equal to 
< = is lower than or equal to 
B begins with 
NB doesn't begin with 
IN includes 
NI doesn't include 
E ends with 
NE doesn't end with ________________________________ 73 
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The operators apply both to text and values. For example, if 
you use the greater than sign (» with text, it means after (as 
determined by ASCII order). So ant is greater than abacus, 
and 19 is greater than 1213. 

The Equal To Operator 

You use the Equal To operator ( =) to select only the 
information that matches the target information exactly. 

For example, you can use Equal To to extract from 
Schedulel a schedule for a specific instructor. 

To do so, first select the Instructor column, then choose 
Select from the Records menu. When the Select dialog box 
appears, click the equal sign button (=). Type Paul 
Winslow in the data field, then click OK. In a moment, only 
those records that list Paul Winslow as the instructor are 
displayed. You can then save the list as a file separate from 
Schedule!, or you can print the list. 

The Not Equal To Operator 

The Not Equal To operator ( < > ) selects only the 
information that doesn't match the target information. 

For example, you can use Not Equal To to extract from 
Cookies a list of all the children who have money due. 

First, open Cookies (don't close Schedule1 - you're going 
to use it again shortly). Select the Money due column, then 
choose Select from the Records menu. When the dialog box 
appears, click the Not Equal To button « ». Type a zero 
in the data field, and click OK. 
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The list that appears contains only the records of the 
children who had a value other than zero in the Money due 
column. 

Close Cookies before you go on. 

The Greater Than Operators 

The Greater Than operator (» selects information that's 
greater in value than the target information or that's after 
the target information in ASCII order. The Greater Than or 
Equal To operator (> =) works in the same way, except it 
also selects the information that matches the target 
information exactly. 

You can use the Greater Than operator to extract a list of 
evening classes from Schedule1 so that you can check for 
conflicts in room assignments. 

First, make Schedule! active, then select the At column. 
Choose Select from the Records menu. When the Select 
dialog box appears, click the Greater Than or Equal To 
button (> =). Evening classes are those that begin at or 
after 6:00 PM - that is, those that begin at a time greater 
than or equal to 6:00 PM. You need to represent 6:00 PM 

in 24-hour format to distinguish it from 6:00 AM. In 24-hour 
format, 6:00 PM is 1800. Type 1800 in the data field, then 
click OK. 

After a moment, only those classes that start in the evening 
are displayed. 

Combining Sorting with Selecting. The easiest way to look 
for classroom conflicts in a short list like the list of evening 
classes is to sort it by classroom. Then any classrooms that 
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have been assigned more than once will appear next to each 
other. 

To sort the list of evening classes, select the Place column, 
then choose Sort Up from the Sort menu. The list is sorted. 

Room 009 appears twice at the top of the list, but if you 
look at the From and To columns, you can see that one of 
the classes the room is used for starts after the other class 
ends. 

Room 114 is used three times. Once again the From and To 
columns show that there's no conflict between Landscaping 
and Real Estate Appraisal, but there is a conflict between 
Real Estate Appraisal and Interior Design. A different 
classroom needs to be found for one of them. 

Room 204 is also used twice, but the From and To columns 
show that one of the classes the room is used for starts after 
the other class ends. 

The Lower Than Operators 

The Lower Than operator ( <) parallels the Greater Than 
operator: it selects information that's lower in value than the 
target information or that's after the target information in 
ASCII order. The Lower Than or Equal To operator « =) 
works in the same way, except it also selects the information 
that matches the target information exactly. 

The Begins With and Doesn't Begin With Operators 

The Begins With operator (B) selects information that begins 
with the character or characters of the target information. 
The Doesn't Begin With operator (NB) does the opposite: it 
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selects only information that doesn't begin with the character 
or characters of the target information. 

For example, if a list of books has a column with the 
Library of Congress catalog number for each book, you 
could use the Begin With operator to select all the books on 
a certain subject regardless of what the books' titles were. 

Here's how to do it: 

First, open the list named Library, and select the Catalog 
Number column. Then choose Select from the Records 
menu. Click the Begin With button (D). To select all the 
books on the theory of relativity, type QC in the data field, 
then click OK. 

The list that appears has three books on it: Einstein's Universe, 
The Relativity Explosion, and The Dancing Wu Li Masters. 
Only one of the books has the word relativity in its title. 

Close Library before you go on. 

The Includes and Doesn't Include Operators 

The Includes operator (IN) selects information that contains 
somewhere in it the target information. The Doesn't Include 
operator (N!) does the opposite: it selects information that 
contains the target information nowhere in it. 

For example, you could use the Doesn't Include operator to 
search a list of homes for sale to find a house without a 
swimming pool (perhaps for a family with small children). 

Here's how: 
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First, open the list named Realestate1, and select the Extras 
column. Then choose Select from the Records menu. When 
the dialog box appears, click the Doesn't Include button 
(N]), then type pool in the data field. Finally, click OK. In a 
moment, a list of only those homes without swimming pools 
appears. 

The Ends With and Doesn't End With Operators 

The Ends With operator (E) selects information that ends 
with the character or characters of the target information. 
The Doesn't End With operator (NE) does the opposite: it 
selects only the information that doesn't end with the 
character or characters of the target information. 

For example, you could extract from a list of medical terms 
all the terms that had to do with inflammations by selecting 
those that end with -ilis. 

Here's how: 

First, open the list named Terms and select the Term 
column. Then choose Select from the Records menu. Click 
the Ends With operator (E), then type His in the data field. 
In a moment, a list of all the words that end with -itis 
appears. 

Compound Selections 

You can use the Select function to search a list for records 
that match two or more selection criteria. For example, you 
can search for records with a specific range of values. Or 
you can select records all of which include two items or all 
of which include one item but don't include another. You 
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can also select the records that include either one thing or 
another, but not necessarily both. 

Close Terms before you go on. 

Selecting a Range of Values 

To select records with a certain range of values, you first do 
a greater than (or greater than and equal to) search, and 
then a lower than (or lower than and equal to) search. For 
example, here's how you would select all the children who 
have sold 18 to 24 boxes of cookies: 

Open the Cookies list and select the Sold column. Choose 
Select from the Records menu. The dialog box appears. 
First, select all the children who have sold 18 or more boxes: 
click the Greater Than or Equal To button (> =), and type 
18 in the data field. Click OK, and in a moment only the 
records of the children who have sold 18 or more boxes are 
listed. 

Next, you select from the limited list you've just created 
only those children who have sold 24 or fewer boxes. The 
Sold column remains selected, so choose Select from the 
Records menu again. The dialog box appears. Click the 
Lower Than Or Equal To button « =), and type 24 in the 
data field. Click OK. In a moment, the records of only 
those children who have sold 18 to 24 boxes remain. 

Close Cookies before you go on. 
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Selecting Both One Item and Another 

To select only the records that include two or more items, 
you use the Select option successively for each item. Doing 
so has the effect of narrowing down the list more each time 
until it contains only the records that have all the items 
you're looking for. For example, here's how to select from a 
list of translators those who speak both French and Spanish: 

Open the list named Translators. Select the column named 
Languages, then choose Select from the Records menu. 
Search for the translators who speak French first: click the 
Includes button (IN), type French in the data field, then 
click OK. The list that appears has the records of only the 
translators who speak French. 

Repeat the process, searching for Spanish: choose Select 
from the Records menu, click the Includes button (IN), type 
Spanish in the data field, then click OK. The new list that 
appears has the records of only those translators who speak 
both French and Spanish. 

Selecting Either One Item or Another 

To select records with either one item or another but not 
necessarily both, you use the Select option to select records 
with the first item, then the Select more option to select 
records with the second. Select more adds records from 
the original list to the list with the first set of records you 
selected. 

This example shows how to select translators who know 
either Russian or Greek: 

Make sure the Languages column is still selected, then 
choose Select from the Records menu. When the dialog box 
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appears, click the Includes button (IN), then type Russian in 
the data field. Click OK. A list of the translators who speak 
Russian appears. 

To add to that list the translators who speak Greek, do this: 
choose Select more from the Records menu, click the . 
Includes button (IN), type Greek in the data field, and click 
OK. In a moment, the translators who speak Greek are 
added to the list. 

Transferring Information Between Lists 

You may find that sometimes when you create ~ new list, 
you need to create a column that has the same mformatlOn 
that a column in an existing list contains. You can use 
Duplicate column to copy all the information from the 
existing list to the new column in the new list. 

To transfer information from one list to another, you start 
by duplicating the column that has the information you 
want to transfer. First, you select the column, then choose 
Duplicate column from the Fields menu. 

This dialog box appears: 

Copy from column: R 

Dlmport 
to column: R 

( ~Jexl ) ( Previous ) ( ["rocl ) 

rsJData only 
t·Jote that this 'Will erose all the data of the torget column ! 
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Instead of copying the infonnation in the column directly to 
another column, you click the Export button to copy the 
information to a special clipboard. It doesn't matter whether 
you select Data only or not: when you click Export, the 
attributes of the column, the formula associated with it (if it 
has one), its name, and so on are automatically copied along 
with the information it contains. You then click OK to copy 
the column to the special clipboard. 

Next, you activate the list you want to transfer the 
information to and select the column you want it copied 
into. You once again choose Dnplicate colnmn from the 
Fields menu. When the dialog box appears, you select 
Import, then click OK. The information is copied from the 
special clipboard to the new column in the new list. 

Copy the information in the Name column in Translators to 
a new list: 

First, select the Name column, then choose Duplicate 
column from the Fields menu. When the dialog box 
appears, click the Export button, then click OK. The Name 
column and its contents are copied to the special clipboard. 

Next, choose New from the File menu. When the new list 
appears, leave column A selected. Choose Duplicate columu 
from the Fields menu, and when the dialog box appears, 
select Import. Finally, click OK. The name of column A 
changes to Name, and the information that was in the Name 
column in Translators appears in it. 

Before you continue, discard the new list by closing it 
without saving it. 
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Shifting Cells 

It's easy when you're working with a list that has many 
columns with the same kind of information (say, dates or 
dollar amounts) to accidentally start entering information in 
the wrong column and not realize you've made a mistake 
until you get to the end of the row. List Plus makes it easy 
to correct a mistake like that with the Shift function. 

To use the Shift function, you first select the farthest left 
cell that contains information that's in the wrong column. 
Then you choose Shift from the Edit menu. This dialog box 
appears: 

Shift the dati] from the cUFn:mt cell: 

~,one cell to the right 

(~one cell to the left 

You select whether you want to shift all the information one 
cell to the right of the cell you've selected or one cell to the 
left. Then you click OK. All the information is automatically 
shifted. 

Try this example: 

Open the list named Realestate2. Move the horizontal scroll 
bar all the way to the right, and you'll notice that, unlike 
Reaiestate1, it has a separate column for each extra feature 
instead of an Extras column. For each house on the list, 
there's a Y or an N in each column to indicate whether the 
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house does or doesn't have the extra feature. You'll notice 
that the ¥s and Ns in the last row are misaligned - they 
need to be shifted one cell to the right. 

Here's what to do: 

Select the last cell in the Garage column, then choose Shift 
from the Edit menu. The dialog box appears. The button 
next to one cell to the right is already selected, so just click 
OK. The dialog box disappears, and List Plus shifts the last 
five cells to the right. 

The cell you selected in the Garage column remains selected 
so you can enter the correct information there immediately. 
Type 1 car, then click OK. 
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~§§~ Printing a Report 

This chapter explains how to create a custom report and 
how to make a printed copy of it. A report is a printed 
summary of all or some of the information in all or some 
of the records in a list. A report can look exactly like the 
printed summary that Print QuickList produces, or it can 
look completely different. You create a custom report by 
arranging the way fields appear in each record and the way 
records appear on a page. You can also add a header and a 
footer to a custom report. 

If you quit List Plus at the end of the last chapter, start it 
again. 

Changing the Display Format 

You may sometimes find it easier to enter information on a 
form or use information that's on a form set up differently 
from the row-and-column format of the standard list. You 
can arrange the layout of any of the .four forms on the 
Records menu any way you want. You can also layout a 
form in the way you want the information in each record to 
appear when you print a custom report. 

The process for laying out a form is the same no matter 
what you intend to use the form for. 

You start by picking the form you want to layout, and then 
choosing Define form from the Records menu. 

The example in this chapter shows you how to arrange a 
form so that you can print both mailing labels and an 
address list. 
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Start by opening AddressBook (open the Samples folder 
first if it isn't open already). When it appears on the 
desktop, choose Form 1 from the Records menu, then 
choose Define form from the same menu. 

The background changes to gray so that you can see the size 
of each field. The screen looks something like this: 

There are four ways you can change a form: you can hide 
fields, change their size, move fields around on the form, or 
add non-data fields to the form. 

Hiding Fields 

You can hide any fields that you don't want to appear on 
the form or that you don't want to appear when you print 
the list. 

To hide a field, you point to it, hold down the option key, 
then hold down the mouse button. A dotted rectangle 
appears. You then move the pointer above and to the left of 
the field until the dotted rectangle disappears, and release 
the mouse button. The field disappears. 

You don't affect the structure of a list by hiding a field, you 
just change the layout of the form. The field you've hidden 

86----------------------------____ ___ 

~:~.~ 

~:: ~ 

~,:~ 

E;'~ 

E.: ..•• ~ 
-~ __ '_.A ~ 

--j 

i~ ·E.', ."-"'! 

I 
E';'~ 

·i; .• l~ 

i; .• : ...•. ~ 
.. ~ 

1i!']3 

i;'i 3 

E.~3 

taJ 3 =1 
E.i 3 
!iE,. ~ 
~l-

Ej.3 
El3 

Er OiiJ 

~rOiiJ 
Ei"~ 
E~ ~ 

Printing a Report 

stilI exists (if you switch to the row-and-column display, 
you'll see it's still there). You can make the fields you've 
hidden reappear at any time by choosing Bring back hidden 
fields from the Records menu. 

Hide all of the fields on the AddressBook form that are 
column names (for example, First Name and Street). You 
don't want them to appear on the mailing labels, and you 
don't really need them on the address list. 

To hide Phone, point to the field where Phone appears, 
hold down option, then press the mouse button. A dotted 
rectangle appears. Keep holding down the mouse button, 
and move the pointer above and to the left of the Phone 
field until the dotted rectangle disappears. Release the mouse 
button. The Phone field disappears. 

Choose Column display to go back to the row-and-column 
format for a moment so that you can see that the Phone 
column stilI exists. To return to the form, click the form 
box. 

Choose Bring back hidden fields from the Records menu, 
and the Phone field reappears, although it's so small, only 
the P is visible. 

Shrinking and Enlarging Fields 

You can shrink and enlarge a field at any time by using the 
same function you used to hide a field. 

You point to the field whose size you want to change, hold 
down option, press the mouse button, and drag the pointer 
until the dotted rectangle is the size you want the field to be 
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- but don't let it overlap any other field. You release the 
mouse button, and the field is redrawn the same size as the 
dotted rectangle. 

If you've set a limit to the size of a field in the Set data 
entry attributes dialog box, shrinking or enlarging the field 
doesn't change that limit. It changes just the display size of 
the field. 

Expand the Phone field back to its original size: 

Point to the Phone field, hold down option, press the mouse 
button, and drag the pointer until the dotted rectangle is 
about the size it was originally. Then release the mouse 
button, and the field is redrawn approximately its original 
size. 

Use the same process to make the field with the street name 
in it larger and the field with the apartment number smaller. 

Hide Phone again, just as you did before. You don't need 
phone numbers for the purposes of this example, so hide the 
field that contains the phone numbers, too. Then hide these 
fields: Last Name, First Name, No., Street, Apt., City, 
State, and Zip. 

Moving Fields 

You can move a field anywhere on a form as long as it 
doesn't overlap any other field. 

To move a field, you point to the one you want to move, 
hold down the command key, and press the mouse button. 
A dotted rectangle the size of the field appears. A horizontal 
dotted line that coincides with the bottom line of the 
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rectangle extends the entire width of the form. While you 
keep holding the mouse button down, you drag the mouse 
to move the dotted rectangle to the place on the form where 
you want the field to appear, then you release the mouse 
button. The field is redrawn in the new location. 

Move the First Name field above the Last Name field, like 
this: 

First, point to the First Name field, then hold down 
command, and press the mouse button. A dotted rectangle 
appears superimposed on the field. Keep holding down the 
mouse button, and move the dotted rectangle to the field's 
new location. Release the mouse button. The First Name 
field is redrawn in its new location. 

Move the Last Name field, the No., Street, and Apt. fields, 
and the City field to the locations shown here: 
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Creating Non-Data Fields 

A non-data field is a field with text that stays the same from 
form to form. For example, you might use a non-data field 
to put a title on a form or to add instructions or an 
explanation about a field to a form. 

To create a non-data field, you point to any part of the gray 
background, hold down option, press the mouse button, 
and drag the mouse. As soon as you start to drag the 
mouse, a dotted rectangle appears. You keep dragging the 
mouse until the rectangle is the shape and size you want the 
field to be (but not overlapping any other fields), then you 
release the mouse button. A field that's the size and shape 
of the dotted rectangle appears. A non-data field looks just 
like a standard field. 

You can add text to a non-data field only when you're 
arranging the form (that is, when the background is gray). 
You can't add text to it when the background of the form is 
white, because only the data fields are active then. 

To add information to a non-data field, you point to it and 
click the mouse button to display the cursor in it. Then you 
type the text you want to appear in it, and press return. 

Use a non-data field to insert a comma between the City 
and State fields: 

Point to the spot just to the right of the upper right corner 
of the box that represents the City field. Hold down option, 
then press the mouse button, and start to drag the mouse 
down and to the right. A dotted rectangle appears. Make 
the dotted rectangle as tall as the City field and about as 
wide as it is tall. Release the mouse button. The field should 
look something like this: 
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Point to the non-data field, and click the mouse button. A 
cursor appears in the field. Type a comma, press the 
spacebar to add a space, then press return. Also add n~n­
data fields to separate the First Name and Last Name fields, 
and the No., Street, and Apt. fields. 

To finish setting up the form, move the State and Zip fields 
and add one more non-data field so that the form looks like 
this: 

When you have all the fields in place, choose Complete 
form from the Records menu. The background of the form 
changes back to white. 

Creating a Custom Report 

The major task in creating a custom report is laying out the 
form. Once you've accomplished that, you can put the 
finishing touches on the report using the Header, Footer, 
and Fields/Records options. 
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You use the Header and Footer options to add a header and 
a footer to a report. You use the Fields/Records option to 
set margins and the number of records on a page, and to 
choose between fixed and floating fields. 

Setting Margins 

You use Fields/Records to set not only top and bottom 
margins, but also the space between records when you're 
printing more than one on a page. 

To set the margins and the space between records, you first 
choose Fields/Records from the Reports menu. This dialog 
box appears: 

FielJJs/Records definition 

Top margin: [lQ] pi:,€ls 8ottom margin: [lQ] pi:Y,8Is 

F:ecoro3 f18r pOLle: @orl8 Ol"jultipla 

FieJd,~: @ Fi:~ed 0 Floating 

Spoce betl,'Jeen r~cord3' [lQ[] pi:~eJs 
o Dra~1 line behllBen reconj$ 

To set the amount of space you want to appear between the 
top edge of the paper and the first line on the first record, 
you type a number in the space next to Top margin. To 
set the amount of space you want to appear between the 
bottom of the last record on a page and the bottom edge of 
the paper, you type a number in the space next to Bottom 
margin. To set the amount of space between the bottom of 
one record and the top of the next, type a number in the 
space next to Space between records. 
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To set up AddressBook so you can print the form you laid 
out earlier in the chapter on standard 3 112 by 15/16 inch 
address labels, type 0 next to Top margin, 0 next to Bottom 
margin, and 60 next to Space between records. 

The size of pixels varies depending on the vertical size 
setting you've selected in the Page SetUp dialog box. Make 
sure you've selected Normal for the address list and the 
mailing labels. 

Setting the Records per Page 

You can choose to print one record on each page or more 
than one. If you choose to print more than one, List Plus 
uses the layout of the form, the top and bottom margins, 
and the space between records you've set to figure out how 
many records to print on each page. If a record won't fit 
completely in the space that's left at the bottom of a page, 
the entire record is moved to the top of the next page. 

To print just one record or more than one record on a page, 
select either One or Multiple from the Fields/Records dialog 
box. 

Select Multiple to print mailing labels and an address list. 

Choosing Fixed or Floating Fields 

You can choose to print all the fields in a record a fixed 
length. If you choose Fixed, List Plus leaves the same 
amount of space for a field every time it prints the field. A 
fixed-length field always begins and ends in exactly the same 
place regardless of the length of the information the field 
contains. 
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Fixed-length fields are best if you're printing information 
that you want to be aligned in columns, like this: 

CLASS SCHEDULE 

9:00 AM 10 9:50 AM Cre.!I"eW,itini Susan Mun,o. 

10:00 AM to 10:50 AM CreatlveWrilini Susan Mun .. " 

11:00 AM to 11:50 AM Ado. Composition Susan Munroe 

1:00 PM to 1:50 PM Drama Susan Munroe 

2:00 PM to 2:50 PM Ameritan CI.ssles Sus." Munroe 

3:00 PM to ~:50 PM WorldUternlure Susan Munroe 

You can also choose to let the length of all the fields in a 
record vary when they're printed, depending on the length of 
the information they contain. If you put more than one field 
on a line, the location of all the fields but the first one 
"float" as the amount of information in each field varies 
(you should always put a non-data field at least one space 
long between floating fields so the information in them 
doesn't run together). The result looks like this: 

Felicia Allen I 11·5735111. Sl 3B 
Astoria, NY 11103 

Martin Morris 
6809 Summit Ave. 

Chris Sanders I Brookline, MA 02146 

2374 Woodside In. I Cincinnati, OH 42539 
Janis Prescott 
6373 Coddington Rd. 
Ithaca, NY 14850 

Select Floating for the mailing labels and address list you're 
going to print. 
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Creating a Header and a Footer 

A header is text that appears at the top of every page of a 
report. It usually contains the title of the report, and it can 
also contain the date and page number (although the page 
number usually goes in the footer). 

A footer is text that appears at the bottom of every page. In 
addition to the page number, you can put the date there. If 
you're creating more than one report from the same list, it's 
also a logical place to put the name of the list the report is 
based on. 

To create a header, you first choose Header from the 
Reports menu. This dialog box appears: 

Print: 

II 

Duale 

D Doge numbBr 

tZl text 

IX1 Print Header 

HeaDar definition 

Justiiication: 

C' Lett 0 Centmd 0 Right 

o Lett 0 Centered 0 Right 

o Left @:' Centered 0 Righi 

@ from PG~e one 

o from page t~!O 

If you want the current date to be part of the header, you 
select date, and then select whether you want it to be aligned 
to the left or to the right or centered. 

_______________________________ 95 



List Plus 

Left alignment means that the first character of the date, 
page number, or text is even with the left margin. Right 
alignment means that the last character is even with the right 
margin. If you center the date, page number, or text, it's 
positioned so that it's evenly spaced between the left and 
right margins. 

If you want the page number to be part of the header, you 
select page number, then select whether you want it to be 
aligned to the left or to the right or centered. 

If you want to add text, such as a title, you select text and 
select the alignment you want for it. Then you type the text 
you want to appear in the header in the space below text. 

There may be times when you don't want the header you've 
created printed on a report. For example, it makes sense to 
print the header on the address list you're going to print, but 
not on the sheets of mailing labels. If you don't want to 
print the header, you click the check box next to Print 
Header to remove the X that appears there. 

If you want the header to be printed on every page of a 
report, you select Print Header and from page one. If you 
want to print the header on every page of the report but the 
first, you select Print Header and from page two. 

For the address list you're going to print, select date and 
Right, and text and Left. In the space below text, type 
Christmas Card List. Since you're going to print the address 
list before the address labels, select Print Header and from 
page one. Finally, click OK. 
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The Footer dialog box looks exactly like the Header dialog 
box and works exactly the same way. 

For the address list, set the footer up this way: select page 
number and Centered, and Print Footer and from page one. 
Click OK. 

Printing a Report 

Printing a custom report works the same way as printing a 
QuickList or using the Print function. 

To print a report, you choose Print Custom Report from 
the Reports menu. The dialog box that appears is just like 
that one that appears when you choose Print QuickList, and 
you select settings in it in exactly the same way. 

Printing an Address List 

Before you print the address list, make sure you've selected 
Normal as the vertical sizing option in the Page SetUp 
dialog box. 

To print an address list, choose Print Custom Report from 
the Reports menu. Make sure the settings selected are the 
right ones, then click OK. 

List Plus prints the address list for you. 
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Printing Mailing Labels 

Before you print mailing labels, first choose Header from 
the Reports menu, click the check box next to Print Header 
to remove the X that appears there, then click OK. Then 
choose Footer, and do the same thing. 

Replace the paper in your printer with a sheet of standard 
3 112 by 15/16 inch address labels. 

To print the mailing labels, choose Print Custom Report 
from the Reports menu. Make sure the settings selected are 
the right ones, then click OK. 

List Plus prints the mailing labels for you. 
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Scroll Bars 

In List Mode. When you're displaying a list on the screen as 
rows and columns, use the horizontal scroll bar to move the 
list left or right in the list window. Use the vertical scroll bar 
to move a list up or down in the list window. 

In Form Mode. When you're displaying each record in a list 
on a separate form, use the horizontal scroll bar to move 
from form to form. Use the vertical scroll bar to move a 
form up or down in the list window. 

if Arrow 
Scroll Box --1" 

To use the scroll bars: 

• Point to the scroll box, hold down the mouse button, and 
move the box in the direction you want the list to move; 
or point to an arrow and click the mouse button. 
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The Boxes 

~ The Close Box. Use the close box to remove a 19 list from the screen. 

The Close Box. Use the close box to remove a list from the 
screen. 

To use the close box: 

• If you want to keep the list you're about to close, save it 
first. 

• Point to the close box and click the mouse button. 

The list disappears from the screen. (If a dialog box appears 
that asks Do you want to save file, see the instructions at 
the beginning of the "File" section.) 

:: EJ:: expand the list window t6 fill the entire desktop ~ 
The Full Size Box. Use the full size box to 

- - below the data entry window (or to return an 
expanded list window to its original size). 

To expand or shrink a list window: 

• Point to the full size box and click the mouse button. 
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§ The Form Box. Use the form box to switch 
CJ from displaying a list in rows and columns to 

displaying each record as a separate form, or 
to switch from a form to rows and columns. When you use 
the form box to switch to a form, it displays the form you 
used most recently. 

To switch from rows and columns to a form: 

• Point to the form box and click the mouse button. 

19]1 The Change Size Box. Use the change size box 
to change the size of a list window. 

To change the size of a window: 

• Point to the change size box, press the mouse button, 
and hold it down. 

An outline appears around the list window. 

• Drag the outline of the window until it's the size you 
want. 

• Release the mouse button. 

The list window is redrawn in the size the outline indicates. 

W4------------____________________ ___ 
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APPLE 

About 

About tells you how much space is available in mem~ry. for 
a list and approximately how many records you can fit .m 
that space. It also gives you information about the verSiOn 
of List Plus you're using. 

To use About: 

• Choose About from the Apple menu. 

A message box with information about List Plus appears . 

• To go back to the list window, click OK. 

Clock 

Use Clock to display the current date and time. 

To use Clock: 

• Choose Clock from the Apple menu. 
______________ 105 



List Plus 

The Clock window appears. It contains the current date 
and time. You can move the Clock window anywhere on 
the screen, just like any other window. 

• To remove the Clock window from the desktop, click its 
close box. 

File 

I I ci 

Open.. d 0r----------;:c;;==."'''''''~ 
C1F)SB 

Rewrt 
Choose printer ... 
PrlQe Setup __ _ 
Print... 

Occasionally, when you choose a selection from the File 
menu, this dialog box may appear: 

Do you 'W'ant to so l,Ie file: 

Rddressesl ? 

It 
\:-

ryeS ) 
( r,lo ) ~ ( Cancel ) 

106 -------------___ _ 

~ .~ 

~.~.~ 

~.~ 

~,~ 
"i 
j 

~:.~ -1-
~l"~ 
':'1 .~ rei -
~l'~ 
Iiiil"~ 

I 
~i'~ 
~i~ 
~i'~ 
i;( .~ I -
~(~ 

I 
~'. '('iiiij I -
i;-L~ 

~r~ 
i;:jiiiij 

;;;;.,.;iOij 
~'r -
~::. ;;;;j 

Reference 

It means you've made changes to the list on the screen since 
you last saved it. The dialog box gives you a chance to save 
those changes . 

The three buttons in the box give you these choices: 

Yes. Click Yes, and a dialog box appears that lets you 
save the list. Name the list if you need to, then click Save. 
Once you've saved the list, the command you've selected 
is carried out. 

No. Click No, and the command you've selected is 
carried out immediately. The list on the screen isn't saved, 
and you can't get it back. 

Cancel. Click Cancel if you decide you don't want the 
command you've selected to be carried out. 

New 

Use New to start a new list. The Clipboard is left as it is. 
You can have up to four list windows open at a time. 

You can't undo New once it has been carried out. 

To use New: 

• Choose New from the File menu, or hold down the 
command key and type N. 

A list window with empty columns appears so you can start 
a new list. 
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Open 

Use Open to redisplay a list you've saved on a disk. You 
can't undo Open once it has been carried out. 

To use Open: 

• Choose Open from the File menu, or hold down the 
command key and type O. 

A dialog box appears. 

Open: 
I2'l /List Plus/Samples 

Addresses it ( Disk ) 
AddressBook 
Cookies 
Library [ Open ] 
Realestate1 
Realestate2 ( Close ) 
Schedule 1 
Terms 

:j} ( Cancel ) 

• Click the name of the list you want to open. 

The buttons in the box give you these choices: 

Open. Click Open to have the list you've selected 
displayed on the desktop. 

The list appears on the desktop in a list window. 

Close. Click Close if there's a folder open and you want 
to close it. If there's no folder open, Close is dimmed. 
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Disk. If the list you want to open is on a disk other than 
the one in the drive, put the new disk in the drive and 
then use Disk to display the names of the lists (and other 
files) on the new disk. 

Cancel. Click Cancel if you decide not to open a list. 

Close 

Use Close to remove a list from the screen. It doesn't save 
the list, and it doesn't give you a new list window. You can't 
undo Close once it has been carried out. 

To use Close: 

• If you want to keep the list you're about to close, save it 
first. 

• Choose Close from the File menu, or click the close box 
(at the left end of the title bar). 

The list disappears from the screen. (If a dialog box appears 
that asks Do you want to save file, see the instructions at 
the beginning of the "File" section.) 

Save 

Use Save to make a permanent copy of a list on a disk. If 
there's already a list (or any other file) on the disk that has 
the same name as the list, the list erases it and replaces it. 

Save also saves any changes you've made to the layouts of 
the four forms available on the Records menu. If you've 
created a custom layout for a report using the options on 
the Reports menu, it saves that layout as well. 
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You can also use Save to create a folder to save lists in. 
Saving lists in a folder is an easy way to keep lists that are 
related together. 

You can't undo Save once it has been carried out. 

To use Save: 

• Choose Save from the File menu, or hold down the 
command key and type S. 

If you've saved the list before, List Plus saves it again 
immediately. 

If you're saving a list for the first time, a dialog box 
appears. 

[g) lList Plusl 
39 K free on aD OK ( Next Drive ) 
o System iI ( Ne\; Folder ) ~List 

o Gslisttools 
o Samples ( Open ) 
o Icons ( [:,n,;) ) 

.(J. 

SO'Je ~s: [ Save ~ 
I ( Cancel ) 

@List Plus Format 

o ASC!! Format 

• Type a name for the list in the space under Save As. 
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You can save a list in either of two formats: 

List Plus Format. Saves not only the information in each 
cell, but also information about the list itself (for example, 
the width of the columns and their attributes, formulas, 
custom report layouts, and so on). 

ASCII Format. Saves all of the information in the list in 
the row-and-column format. Each column is separated by 
a tab. No information about the list itself is saved. 

The buttons in the box give you these choices: 

Next Drive. If you want to save the list on a disk other 
than the one in the drive, replace the disk in the drive with 
the new disk. Use Next Drive to display the names of the 
documents on the new disk. 

New Folder. To create a new folder, type a name for it 
in the space under Save As, then click New Folder. Use 
Open to open the new folder whenever you want to save a 
list in it. 

Open. If you want to save a list in ,a folder, select the 
folder from the catalog and click Open. 

Close. You can use Close only if a folder is open. Use 
Close to close the folder. 

Save. Click Save when you're ready to save the list. 

If a dialog box appears that says Volume full, there isn't 
enough room on the disk to save the list. Click OK, then 
eject the disk from the drive and replace it with a disk 
that has space on it. 

Cancel. Click Cancel if you decide not to save the list. 
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Save As 

Use Save As to save different versions of the same list. You 
first give a new name to a list you've already saved, and 
then save the list under the new name. 

As long as you give the new version a different name, Save 
As, unlike the Save command, doesn't replace the old list 
with the new one. 

You can't undo Save As once it has been carried out. 

To use Save As: 

• Choose Save As from the File menu. 

A dialog box appears that's just like the one that 
accompanies the Save command. The functions of the 
buttons and the formats that are available are explained 
above. 

Revert 

Use Revert to replace the list on the screen with the last 
version you saved. Revert has the effect of letting you undo 
all the changes you've made to a list since the last time you 
saved it. You can't undo Revert once it has been carried 
out. 

To use Revert: 

• Choose Revert from the File menu. 

A dialog box appears. It asks you if you want to revert to 
the last version saved. 
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I B Revert to IllSt SI]V81j version of Ulis Iht ? 

The buttons in the box give you these choices: 

OK. Click OK to replace the list on the screen with the 
version that's on the disk. The list window goes blank, 
and after a moment, the last version saved appears. 

Cancel. Click Cancel if you decide you don't want to 
revert to the previous version. 

Choose Printer 

Use Choose printer to let List Plus know what type of 
printer you have connected to your computer and which 
port the printer is connected to. . 

If you're using AppleTalk, see "Using AppleTalk" later in 
this section, then follow the instructions below. 

To use Choose printer: 

• Make sure that the List Plus system disk is in the disk 
drive that's active. 

• Select Choose printer from the File menu. 
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A dialog box appears. 

Choose Printer v 1.3 

( Cancel) (( OK ) 

• Select one of the printers from the printer type catalog. 
Use the arrows to scroll the list up or down if you need to. 

• Select one of the ports from the printer port catalog. 

The buttons in the box give you these choices: 

OK. Click OK when you've selected your printer and the 
port it's connected to. 

Cancel. Click Cancel to return any settings you've 
changed to the way they were originally and to return to 
the list window. 

ll4----------------______________ _ 
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Using AppleTalk. If you choose AppleTalk as the printer 
port: 

• Go to the Control Panel. To do so, first hold down 
control and the command key, then press esc. 

The list window disappears and the Desk Accessories 
menu appears: 

ContrDI Panel 
Alternate Displ.3l~ r10de 
!1anl~18r 

LO",j81" DUmp8r" 

Clui t 

• Select Control Panel, then press return . 

The Control Panel menu appears. 

Open' ~ 

• Use the arrow keys to highlight Slots, then press return. 

A listing appears with the settings of your computer's 
slots. 

• Use the np and down arrow keys to highlight Slot 1, then 
use the right arrow key to display Vonr Card next to it. 

Note: Make sure Slot 1 is not set to Printer Port, or your 
computer will stop working when you try to use AppleTalk. 
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• Use the arrow keys to highlight Slot 7, and set it to 
Built-in AppleTalk. 

• Press return to save the slot settings and to return to the 
Control Panel menu. 

• Select Quit to return to the Desk Accessories menu. 

• Select Quit on the Desk Accessories menu to go back to 
List Plus. 

• If you've made changes to the lists in any of the list 
windows that are open, save them. 

• Close all the list windows, quit List Plus, and turn the 
computer off. 

The changes you made to the settings of the slots on the 
Control Panel won't take effect until you start the computer 
again. 

• Turn on the computer again and restart List Plus. 

• Follow the instruction for using Choose printer above, and 
choose AppleTalk from the printer port catalog. 

When you're finished using AppleTalk, go to the Control 
Panel and change the settings of the slots back to the way 
they were. Then turn the computer off, turn it back on 
again, and restart List Plus. 

Page SetUp 

Use Page SetUp to indicate how your printer is to print a 
list or report on the page. 
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Page SetUp is different from a report's layout. A report's 
layout is made up of margin settings, fixed or floating 
fields, and so on (for information about laying out a report, 
see "Reports," the section on the Reports menu). Page SctUp 
determines how a report appears on a page: you can, for 
example, print a report on its side (with the lines of text 
parallel to the long edge of the paper rather than the short 
edge), or you can print text at half its usual size. 

The settings you choose are saved when you save the list. 

To use Page SetUp: 

• Choose Page SetUp from the File menu . 

A dialog box appears. The settings you can choose from 
differ depending on the type of printer you selected in the 
Choose printer dialog box . 

ImageWriter. If you chose ImageWriter in the Choose 
printer dialog box, the Page SetUp dialog box looks like 
this: 

II-IAGWRITER/PF:INTm \0' 1.3 
Poper: @ US LeUer 

o US L''J'll 
o InternotiorlOl Fanfold 
o R4 LeUer 

'.)erticol Sizing: 

@Normal 

() Condensed 

Orientation: 

SpeGiol Weets: 

050% Reduction 
D No Gaps Behl8efl 

POQ8S 

) ( or; ),i 
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These are the settings you can choose from: 

Paper: 

US Letter. For paper 8 1/2 inches wide and 11 inches tall. 
(This option is automatically selected.) 

US Legal. For paper 8 1/2 inches wide and 14 inches tall. 

International Fanfold. For international standard paper, 
8 1/4 inches wide and 12 inches tall. 

A4 Letter. For European standard paper, 8 1/4 inches 
wide and 11 2/3 inches tall. 

Vertical Sizing: 

Normal. The printed text looks just like it does on the 
screen - the page is printed with the same number of 
rows of dots as the text on the screen is displayed in. (This 
option is automatically selected.) 

Condensed. The list is printed half the height of the list 
on the screen, but with the same number of dots as a 
normal list. 

Special Effects: 

50% Reduction. The list is printed half its normal size. 

No Gaps Between Pages. The list is printed continuously, 
without page breaks. 
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Orientation: 

~ 
Tall ~ 

§:ll 
~ Wide 

Tall. The text is printed upright on the page, with the top 
line at the top of the page. (This option is automatically 
selected.) 

Wide. The text is printed sideways on the page, with the 
top line down the right side of the page. 

LaserWriter. If you chose LaserWriter in the ~hoo~e printer 
dialog box, the Page SetUp dialog box looks hke thIs: 

LASER~IRITER/APPLETALK vi.l 
Poper: @U8letter 0 Rll Letter 

o US Legal 0 85 Letter 
Orientation: 

Printer Effects; 

r2l8moothing? 

~I ertical Sizing: 

@flermol 
o Intermediate 
o Condensed 

Reduce or Iillm]% 
Enlarge: 

[SJ Font Substitution? 

~KOK » 

These are the settings you can choose from: 

Paper: 

US Letter. For paper 8 112 inches wide and 11 inches tall. 
(This option is automatically selected.) 
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US Legal. For paper 8 112 inches wide and 14 inches tall. 

A4 Letter. For European standard paper, 8 114 inches 
wide and 11 2/3 inches tall. 

B5 Letter. For paper 15 inches wide and 11 inches tall. 

Orientation: 

Irffil Tall~ ~
. 

:-=1 
• Wide 

Tall. The text is printed upright on the page, with the top 
Ime at the top of the page. (This option is automatically 
selected.) 

Wid~. The text is printed sideways on the page, with the 
top Ime down the right side of the page. 

Vertical Sizing: 

Normal. The printed text looks just like it does on the 
screen (the page is printed with the same number of rows 
of dots as the text on the screen is displayed in). 

Intermediate. The printed text looks two-thirds as high as 
the text on the screen (the page is printed with one and a 
half times the number of rows of dots as the text on the 
screen is displayed in). Select this option to fit a full page 
of text on paper that's being printed in the Wide rather 
than the Tall orientation. 
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Condensed. The text is the same height as it appears on 
the screen, but it's printed with twice as many rows of 
dots as the text on the screen is displayed in. The result is 
a high-resolution printed copy that resembles what a 
Macintosh would produce. 

Printer Effects: 

Smoothing. The printer adds extra dots in between points 
that form a line to produce a higher-resolution copy. (This 
option is automatically selected.) 

Font Substitution. When you use certain fonts, a 
LaserWriter substitutes different fonts for the ones you've 
used when it prints the list out. List Plus uses a font 
named Shaston. A LaserWriter substitutes Helvetica for 
Shaston automatically whether or not you've selected this 
option. 

Reduce or Enlarge. To reduce or enlarge the text of the 
list, type the percentage you want the text reduced or 
enlarged in the space next to Reduce or Enlarge. 

You can type a number from 25% to 400% (50% reduces 
the text to half its normal size; 200% enlarges the text to 
twice its normal size). 

The buttons in the box give you these choices: 

OK. Click OK to record the settings you've chosen. 

Cancel. Click Cancel to return any settings you've 
changed to the way they were originally and to return to 
the list window. 
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Print 

Use Print to print the list in the list window that's currently 
active. If you're displaying each record on a separate form, 
use Print to print all the records in the list. 

There's a difference both between Print and Print QuickList 
and between Print and Print Custom Report: 

Print QuickList always prints a list as rows and columns 
regardless of whether a form or the row-and-column format 
is displayed. Print, on the other hand, produces a printed 
copy that matches the format that's displayed. Print 
QuickList also prints the name of the list at the top of the 
page and the page number at the bottom. Print does 
neither. (For more information, see "Print QuickList" under 
"Reports. ") 

Print Custom Report lets you print records only form by 
form. It also lets you add headers and footers, set top and 
bottom margins, print more than one record on a page, and 
choose fixed or floating fields. Priut lets you do none of 
those things. (For more information, see "Print Custom 
Report" under "Reports.") 

To stop printing once it has started, hold down the 
command key and type a period. 

To use Print: 

• Choose Print from the File menu, or hold down the 
command key and type P. 

A dialog box appears. The settings you can choose from 
differ depending on the type of printer you selected in the 
Choose printer dialog box. 

U2-----------------------------------
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ImageWriter. If you chose ImageWriter in the Choo~e 
printer dialog box, the Print dialog box looks hke this: 

QualitlJ: 0 Better 
@ [letter ColDr 
o Draft 

Prlge r@ge: 
@ All 

o From: 0 To: 0 
Copies: [0 
Poper Feed:I~' Automatic 0 H@d Feed 

DCoI,r ~~ 

These are the settings you can choose from: 

Qnality: 

Better. Produces the highest quality printed copy, but 
takes the longest to print. Better produces high-quality 
printed text by using a font that's twice the size of the 
actual font you've used, then condensing that font to half 
its size. 

Better Color. Produces a high-quality printed copy and 
takes less time than Bettcr to print. (This option is 
automatically selected.) 

Draft. Produces a printed copy more quickly than either 
Better or Better Color. 

Page Range: 

All. All the pages of the list are printed. (This option is 
automatically selected.) 

-----------------------------U3 



List Plus 

From: __ To: __ . Lets you pick a range of pages you 
want List Plus to print. Click the button to the left of 
From, then type the numbers of the first and last pages 
you want to have printed. 

Copies: If you want more than one copy, type the 
number of copies you want. 

Paper Feed: 

Automatic. For continuous computer paper. (This option 
is automatically selected.) 

Hand Feed. For single sheets of paper that you feed into 
the printer by hand, one at a time. 

Color. This option is for use only with applications such 
as Paintworks Plus, Writer's Choice elite, or Draw Plus 
that produce files that contain color. 

LaserWriter. If you chose LaserWriter in the Choose printer 
dialog box, the Print dialog box looks like this: 

LASER~JRlTER/PRniT£R vl.1 
Pages: @ All 

o From:O To: 0 
CODies:[] 

Poper Source: 
@PaDerTray 
o Hanuol Feed 

~CD 

These are the settings you can choose from: 

Pages: 

All. All the pages of the list are printed. (This option is 
automatically selected.) 
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From: __ To: __ • Lets you pick a range of pages you 
want List Plus to print. Click the button to the left of 
From, then type the numbers of the first and last pages 
you want to have printed. 

Copies: If you want more than one copy, type the 
number of copies you want. 

Paper Source: 

Paper Tray. For paper that's in a cassette. (This option is 
automatically selected.) 

Manual Feed. For single sheets of paper that you feed 
into the printer by hand, one at a time. 

The buttons in the box give you these choices: 

OK. When you've selected the settings you want, click OK 
to start printing. 

Cancel. Click Cancel to return to the list window without 
printing the list. Any settings you've changed are returned 
to the way they were originally. 

Quit 

Use Quit to leave List Plus. You can't undo Quit once it has 
been carried out. 

To use Quit: 

• If you want to keep the list that's on the screen, save it. 

o Choose Quit from the File menu, or hold down the 
command key and type Q. 
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The .entire screen is erased, and you can start another 
apphcatJ?n. (If a di~log box appears that asks Do you want 
to save fiI~, see the illstructions at the beginning of the 
"File" sectIOn.) 

Edit 

Undo 

Use Undo to cancel the last change you made to a list. 

Note: You can't use Undo to cancel any of the commands 
on the File or Fields menus. 

To use Undo: 

• Pull down the Edit menu and click Undo; you can also 
hold down the command key and type Z. 

The last change you made to the list is canceled. 

Cut 

Use Cut together with Paste to move all or part of the 
information .in a cell to another cell (the cell can be in the 
same hst or ill another list). 
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To use Cut: 

• Select the information you want to cut. The information 
you select must be in the data entry box. 

• Choose Cut from the Edit menu, or hold down the 
command key and type X. 

The information you've selected disappears from the screen 
and is placed on the Clipboard. You can now go to the new 
location where you want to put the information and use the 
Paste command to place the information there. 

Copy 

Use Copy to make one or more copies of all or part of the 
information in a cell. 

If you want to make a copy of an entire row, see "Duplicate 
Row" later in this "Reference" section. If you want to 
duplicate a column, see "Duplicate Column" also later in 
this "Reference" section. 

To use Copy: 

• Select the information you want to copy. The information 
you select must be in the data entry box. 

• Choose Copy from the Edit menu; you can also hold 
down the command key and type C. 

A copy of the information you've selected is placed on the 
Clipboard. 

• To insert a copy of the information, use the Paste 
command. 
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Paste 

Use Cut together with Paste to move information from one 
cell to an~ther (the second cell can be in the same list or in a 
?lfferentyst). If you want to move a copy of the information 
~n a cell mstead of the original information itself, use Copy 
illstead of Cut. 

To use Paste: 

• First select the information you want to move, and then 
use Cut or Copy. 

• Go to the place you want to move the information to. 
'! ou can go to another part of the same list or to another 
list. 

• Choose Paste from the Edit menu, or hold down the 
command key and type V. 

~epeat the last two steps if you want to insert the information 
ill ~ore than one cell. The information stays on the Clipboard 
until you cut or copy something else. 

Clear 

Use Clear to erase information from a cell. 

To use Clear: 

• Select the cell you want to erase. 

• Choose Clear from the Edit menu, or press delete. 

The cell you've selected is erased. 
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Shift 

Use Shift to move information one cell to the left or right of 
its current location. Shift moves not only the information in 
the cell you've selected, but also the information in all the 
cells to the right of the selected cell. 

You may, when you're working with a list that has many 
colunms with the same kind of information (say, dates or 
dollar amounts), accidentally start entering information in 
the wrong column and not realize you've made a mistake 
until you get to the end of the row. Shift is designed to 
correct a mistake such as that easily . 

To use Shift: 

• Select the leftmost cell that contains information that's in 
the wrong column . 

• Choose Shift from the Edit menu. 

This dialog box appears: 

Shift the dota from the current cel!: 

(~) one cell to the right 

o one C81! to the left 

(( CGneel 21 ( OK 

These are the options you have to choose from: 

one cell to the right. Shifts the information in the cell 
you've selected and the information in all the cells to the 
right of it one cell to the right. 
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one cell to the Jeft. Shifts the information in the cell 
you've selected and the information in all the cells to the 
right of it one cell to the left. 

The buttons in the box give you these choices: 

OK. Click OK to shift the information one cell in the 
direction you've chosen. 

Cancel. Click Cancel to return to the list without shifting 
information. 

Insert Row 

Use Insert row to insert a blank row above the row that's 
currently selected. 

To use Insert row: 

• Select the row you want the new row to be above. 

• Choose Insert row from the Edit menu, or hold down the 
command key and type J. 

A blank row is inserted above the row you selected. The 
new row is automatically selected. 

Delete Row 

Use Delete row to remove the row you've selected from the 
list. 

To use Delete row: 

• Select the row you want to delete. 
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• Choose Delete row from the Edit menu, or hold down the 
command key and type L. 

The row you selected is removed from the list. 

Duplicate Row 

Use Dnplicate row to make a copy of the row you've 
selected. The copy of the row is inserted below the row 
you're copying. 

To use Duplicate row: 

• Select the row you want to copy. 

• Choose Duplicate row from the Edit menu, or hold down 
the command key and type G. 

A copy of the row you selected appears below the selected 
row. 

Fields 
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Add Column 

Use Add column to add a column to the right of the 
column that's currently farthest right. 

You can't undo Add column once the new column has been 
added. Use Delete column to remove the new column. 

To use Add column: 

• Choose Add column from the Fields menu, or hold down 
the command key and type A. 

A prompt that says Columu name appears in the data 
entry window. 

• Type a name for the column, then click OK. 

The new column appears to the right of the column that's 
currently farthest to the right. 

Insert Column 

Use Insert column to add a column between existing 
columns. 

You can't undo Iusert column once the new column has 
been added. Use Delete column to remove the new column. 

To use Insert column: 

• Select the column to the right of the place where you want 
the new column to be added. 
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• Choose Insert column from the Fields menu, or hold 
down the command key and type I. 

A prompt that says Column name appears in the data 
entry window. 

• Type a name for the column, then click OK. 

The new column appears to the left of the column you 
selected. 

Delete Column 

Use Delete column to remove a column from the list 
permanently. 

You can't get a column back once you've deleted it. 

To use Delete column: 

• Select the column you want to delete. 

• Choose Delete column from the Fields menu, or hold 
down the command key and type K. 

This dialog box appears: 

Rbout to delete column: 

R 

( cancel) [ OK ) 
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The buttons in the box give you these choices: 

OK. Click OK to delete the column you've selected. 

Cancel. Click Cancel to return to the list without deleting 
the column. 

Move Column 

Use Move column to change the place a column appears in 
a list. 

To use Move column: 

• Select the column you want to move. 

• Choose Move column from the Fields menu. 

r;::::::::, The pointer changes from an arrowhead to a L.!::J little truck, like the one at the left. 

• Press the mouse button. 

When you do, an outline of the column you've selected 
appears. 

• Keep holding the mouse button down, and move the truck 
icon to the place where you want the column to be moved 
(List Plus inserts the column to the left of the column you 
move the truck to). 
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• Release the mouse button. 

The column you selected moves to its new position, and all 
the columns to the right of it are redrawn. 

Duplicate Column 

Use Duplicate column to copy the contents of a column to 
another column. You can copy the contents of a column to 
a column in the same list or to one in another list. You can 
copy the contents of a column only to another column that 
already exists. 

You can't undo Duplicate column once the contents of the 
column have been copied to another column . 

To use Duplicate column: 

• If you need to create a new column to .rec~ive a copy of 
the contents of the column you're duphcatmg, use Add 
column or Insert column. 

• Select the column you want to copy. 

• Choose Duplicate column from the Fields menu, or hold 
down the command key and type H. 

This dialog box appears: 

Copy from column: 

to column: 
o Import 
R 

~ ( Previnus ) ~ 

r;:;'jDolo Dnly 
tMe that this \ifill emse all the Data a/the target column! 
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To co~y information from one column to another in th 
same lIst: e 

• Use the Next and Previous buttons to display next to 
~o column the name of the column you're copying the 
mformatIOn to, then click OK. 

To copy information from a column in one list to a column 
m another lIst: 

• Clic,k Export to copy the information in the column 
you ve selected to a special clipboard, then click OK. 

o Activate the list you want to copy the information to. 

o Select the column you want to copy the information to. 

o Choose Duplicate from the Fields menu, or hold down the 
command key and type H. 

• When ~he dialog box appears, select the Import option 
then clIck OK. ' 

These are the options you can choose: 

Import .. Select Import to transfer information from a 
column m one list to a column in another list, rather than 
from one column to another within the same list. Before 
~ou use ~mport, use Export to make a copy of the 
mformatlOn you want to transfer. 

If you're importing a column that has a formula any 
column .names that the formula contains are im;orted 
along ~Ith the formula. Make sure that you change the 
~ames ~n the form~la to match the column names in the 
hst you re transferrmg the information to. 
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Data only. If you choose Data only, only the information 
in the column you've selected is copied. If you don't choose 
Data only, the column's name, its attributes and formula (if 
it has one) are copied along with the information it contains. 
If you've chosen Export, the column's name, its attributes 
and formula are copied whether you've selected Data only or 
not. 

The buttons in the box give you these choices: 

Next. Click Next to display the name of the column that's 
to the right of the colunm whose name appears following 
to column. If the name displayed there belongs to the 
rightmost colunm, clicking Next wraps around to display 
the name of the leftmost column. 

Previous. Click Previous to display the name of the 
column that's to the left of the column whose name 
appears following to column. If the name displayed there 
belongs to the leftmost colunm, clicking Next wraps 
around to display the name of the rightmost column. 

Export. Click Export to copy the 'contents of the column 
to a special clipboard so that you can transfer the contents 
to a column in another list. 

Cancel. Click Cancel to return to the list without 
duplicating the contents of the selected colunm. 

OK. Click OK to copy the contents of the colunm you've 
selected to the colunm whose name is displayed following 
to column. If you've clicked Export, clicking OK transfers 
the contents of the colunm to a special clipboard. If 
you've selected Import, clicking OK transfers the 
information on the special clipboard to the colunm you've 
selected. 
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Set Data Entry Attributes 

Use Set data entry attributes to limit the kind and amount 
of information that can be entered in a column, to set a 
default value for a column, or to create a formula for a 
column. 

To use Set data entry attributes: 

• Select the column you want to set data entry attributes 
for. 

• Choose Set data entry attributes from the Fields menu, or 
hold down the command key and type E. 

This dialog box appears: 

I 
j (::) i=HprlFlnumBric 

(J Ilumeric 

Limit input ~i~e 10' 

o Formula 

Datil entry For' 

o Rlphabetic 

o Di~1it$ c1nly 

GQ] characters 

o DB/crull '.olue 

These are the options you have to choose from: 

Alphanumeric. Allows the letters A through Z (both 
upper- and lowercase), the digits 0 through 9, punctuation 
mar~s, and symbols (such as the ampersand (&), the 
asterIsk (*), and so on). (This option is automatically 
selected.) 

BS----------__________________ __ 

~~ 

r;;; ... :3 

~ !3 

~.'!3 

~.' '!3 

E! .. ' .!3 
11:::. :.iiij 
~I"-
~f'~ -I -
~j'~ 
~,~ 
-] 

~'·"rr·"·~ 
-I 
~1~ 
~I~ 
~l~ 
E"''''-iij ]. ' 

.-..,. .. ~ 
co]' 
E",··-iij 

] 
o::::~~ 
~l 
E:j ii«j 

E;"" 1iiij 
'~I 
E_~ .. lliij 
I!"]' 
E':" .. ·~ 

Reference 

Alphahetic. Allows only the letters A through Z (both 
upper- and lowercase) and spaces. 

Numeric. Allows only numbers, the decimal point (.), the 
plus ( + ) and minus ( - ) signs, and spaces. 

Digits only. Allows only the digits 0 through 9. 

Limit input size to: __ characters. Type a number from 0 
to 255 to limit the number of characters that can be . 
entered in any cell in the column you've selected. The size 
is automatically set at 80 characters. 

The limit you set affects the amount of space set aside in 
memory for a list. If you leave the limit set at 80 
characters every time you add a record - even If the 
record is blank - 80 characters of space is set aside in 
memory for each column in the list. Even if the 
information you add to a column takes only 5 characters, 
80 characters is still set aside in memory. You can create 
room in memory for more records by limiting each 
column to the number of characters you expect the longest 
entry in the column to contain. 

Formula. Select Formula to activate the buttons in the 
lower part of the box so you can enter a formula. 

A formula can include: 

• Constants, which are values or sets of characters that 
stay the same each time the formula is calculated. 

• Numbers 

• Alphanumeric characters, placed inside quotation marks 
(" ... "). For example, "Chicago, IL 30303". 
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• Dates, placed inside quotation marks (" ... "). For 
example, "6/2/88". 

• Column names, placed inside square brackets ([ ... J). For 
example, [Address]. A column name stands for in turn , , 
the value or set of characters in each of the cells in the 
column named. A column name is a variable, rather 
than a constant, because the actual value or set of 
characters it represents may be different for each record. 

• Operators such as the plus sign ( + ) or the division sign 
(I). 

• Functions such as @SUMor @TODAY. 

• Conditional expressions (IF ... THEN ... ELSE) preceded 
by the at sign (@). For example, @IF(BALANCE=O) 
THEN ("Overdrawn") ELSE ("Okay"). 

A formula can be made up of just constants (for example, 
1 + 0.065), of just variables (for example, [PRICE] * 
[TAX]), or of a mixture of constants and variables (for 
example, [CITY] + ", IL" + [ZIP])~ 

A formula can be no longer than the formula entry line. 
If the formula you want to create won't fit, try using 
shorter column names. You can also break a long formula 
into its component equations, then insert a column for 
each equation (making each equation a formula for its 
respective column), and finally create a formula to 
combine the results of each of the component equations. 

A formula is calculated once for each record in a list, and 
each time it's calculated it uses only the values in a single 
row (for example, you can't multiply the price of an item 
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in one row by the quantity in a different row). The results 
are displayed in the column that's selected when you create 
the formula . 

Default value. Select Default value if you want to be able 
to replace the value or set of characters that a formula 
displays in a cell. 

Enter a number in the data entry line at the bottom of the 
dialog box, then select Default value to display that number 
as the default value in every cell in the column. 

The buttons have these functions: 

Field: 

Next. Click Next to display the name of the column 
that's to the right of the column whose name appears 
next to Field. If the name displayed there belongs to 
the rightmost column, clicking Next wraps around to 
display the name of the leftmost column. 

Previous. Click Previous to display the name of the 
column that's to the left of the column whose name 
appears next to Field. If the name displayed there 
belongs to the leftmost column, clicking Next wraps 
around to display the name of the rightmost column. 

Put in formula. Click Put in formula to add the name 
of the column displayed next to Field to the data entry 
line. Remember that a column name is a variable, and 
that a formula is calculated once for each record in a 
list. When List Plus calculates the formula for a record, 
it replaces the column name with the value in that 
column in the current record. 
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Operator: 

+ Adds two numbers together. 

Joins two sets of alphanumeric characters. For 
example, "Chicago" + "," + "IL" equals 
"Chicago, IL." 

Adds a number of days to a date function to get a 
date. For example, if today is December 25, 1987, 
then @TODAY + 7 equals "1/1/88." 

Subtracts one number from another. 

Removes one set of alphanumeric characters from 
another. For example, "oxygen" - "yg" equals 
"oxen. " 

Subtracts a number of days from a date to get 
another date. For example, if today is December 
25, 1987, then @TODAY - 7 equals "12/18/87." 

Multiplies two numbers. 

Divides one number by another. 

Gives the location where one set of alphanumeric 
characters appears within another set. For example, 
"cola" /"chocolate" equals 4 because the first letter 
in cola is the fourth letter in chocolate. If one set 
of characters doesn't appear in the other set 
exactly, the result is zero; for example, 
"cola" /"co{{aterar equals zero. 

(and) An equation inside parentheses is worked out 
before any equations outside the parentheses. For 
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example, 4 * (3 - 1) equals 8 because 1 is first 
subtracted from 3, then the result (2) is multiplied 
by 4; but 4 * 3 - 1 equals 11 because 4 and 3 are 
first multiplied, then 1 is subtracted from the result 
(12). 

Indicates that the word following the at sign is a 
function. For example, @RND(lO) indicates that 
RND is the random number function. (@RND(lO) 
equals a random number between 1 and 10.) 

Calculates a percentage by multiplying the number 
following the percent sign by 1l100th of the 
number before the percent sign. For example, if the 
value in the column named Amount is 200, 2% 
[AMOUNT] equals 4 because 200 times .02 equals 4. 

Indicates if one set of alphanumeric characters is 
included in another set. For example, "cola" % 
"chocolate" equals TRUE because cola is included 
in chocolate. If one set of characters doesn't appear 
in the other set exactly, the result is FALSE; for 
example, "cola" % "co{{ateral" equals FALSE. 
TRUE and FALSE are called logical values. 

You can also use these operators although there are no 
buttons for them: 

\ Produces the remainder of a division calculation. 
For example, 17 \ 5 equals 2 because if you divide 
17 by 5, the result is 3 with 2 left over. 

& Compares two logical values to see if they're the 
same. There are two logical values, TRUE and 
FALSE. If you compare two logical values that are 
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the same, the result is TRUE; otherwise the result 
is FALSE. For example, FALSE & FALSE is 
TRUE, but FALSE & TRUE is FALSE. 

Compares two logical values to see if either one is 
TRUE. If either of the values is TRUE, the result 
is TRUE; if neither of the values is TRUE, the 
reuIt is FALSE. For example, TRUE I FALSE is 
TRUE, but FALSE I. FALSE is FALSE. 

In an If/Then formula, the If clause is true if the 
value, text, or date before the equal sign is the 
same as the value, text, or date after it. For 
example, if the date in the DATE column is 
"10/10/88;' @IF([DATE] ="10/10/88") THEN 
("Yes") ELSE ("No") equals "Yes:' But if the date is 
"10/11/88;' the formula equals "No:' 

In an If/Then formula, the If clause is true if the 
value, text, or date before the not equal to sign is 
different from the value, text, or date after it. For 
example, if the date in the DATE column is 
"10/10/88;' @IF([DATE] ;<"10/10/88'') THEN 
("No") ELSE ("Yes") equals "Yes:' But if the date is 
"10/11/88;' the formula equals "No:' 

To display the not equal to sign (;<), hold down 
the option key and type an equal sign ( = l. 

In an If/Then formula, the If clause is true if the 
value, text, or date before the greater than sign is 
greater than the value, text, or date after it. If the 
information in the column is numeric, greater than 
means "is larger than." If the information is a date, 
greater than means "after:' If the information in the 
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column is alphabetic or alphanumeric, greater than 
means "has a higher ACSII value" (see the Appendix, 
"ASCII Values," for more information). 

Examples: 

zebra is greater than ant because z has a higher 
ASCII value than a. 
1213 is greater than 19 if the format for the column 
is numeric. 
19 is greater than 1213 if the format for the column 
is alphanumeric: both Is have the same ASCII value, 
but 9 has a higher ASCII value than 2. 

So, if the text in the ANIMAL column is "zebra;' 
@IF([ANIMALJ>"ant") THEN ("Yes") ELSE 
("No") equals "Yes:' But if the text in the ANIMAL 
column is "albatross;' the formula equals "No:' 

> In an If/Then formula, the If clause is true if the 
value, text, or date before the greater than or equal 
to sign is the same as or larger than the value, text, 
or date after it. For example, if the value in the 
BALANCE column is $1.00,@IF([BALANCE]2:0) 
THEN ("Okay") ELSE ("Overdrawn") equals 
"Okay:' But if the balance is - $1.00, the formula 
equals "Overdrawn:' 

To display the greater than or equal to sign, hold 
down option and type a greater than sign (». 

< In an If/Then formula, the If clause is true if the 
value, text, or date before the less than sign is less 
than the value, text, or date after it. If the 
information in the column is numeric, less than 
means "is smaller than." If the information is a 
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date, less than means "before:' If the information in 
the column is alphabetic or alphanumeric, less than 
means "has a lower ACSn value" (see the Appendix, 
"ASCn Values," for more information). 

Examples: 

ant is less than zebra because a has a lower ASCII 
value than z. 
19 is less than 1213 if the format in the column is 
numeric. 
1213 is less than 19 if the format for the column is 
alphanumeric: both Is have the same ASCII 
value, but 2 has a lower ASCII value than 9. 

So, if the text in the ANIMAL column is "zebra;' 
@IF[ANlMALJ<"ant") THEN ("Yes") ELSE 
("No") equals "No:' But if the text is "albatross" 
the formula equals "Yes:' , 

In an IfIThen formula, the If clause is true if the 
value, text, or date before the less than or equal to 
sign is less than or the same as the value, text, or 
date after it. For example, if the value in the 
TEMPERATURE column is 32, 
@IF([TEMPERATUREJ-::;32) THEN ("Freezing") 
ELSE ("Okay") equals "Freezing:' If the value in 
the TEMPERATURE column is 20, the formula 
also equals "Freezing:' But if the value is 33, the 
formula equals "Okay:' 

To display the less than or equal to sign, hold 
down option and type a less than sign «). 
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You can use the following functions either in a formula or 
alone. Numbers in a function are represented by n, two or 
more numbers are represented by n, . .. (you have to 
separate two or more numbers with commas). Dates are 
represented by d; dates have to be inside quotation marks, 
and they have to be in the form MM/DD/YY. 

@ABS(n) calculates the absolute value of the value inside 
the parentheses (a value can be a number or a column 
name, such as [AMOUNT]). The absolute value of a 
number is always positive. For example, if the value of 
[BALANCE] is $573.38, @ABS([BALANCED equals 
573.38. 

@AVERAGE(n, . .. ) finds the average of the values inside the 
parentheses (a value can be a number or a column name, 
such as [AMOUNT]). For example, @AVERAGE(IO,20) 
equals 15. 

@COUNT([name], ... ) gives the number of cells in the 
columns you name that have information in them in the 
current record. For example, @COUNT([CITYJ,[STATE], 
[ZIP]) equals 2 if you have a city and state but no zip 
code for a certain record. 

@DATE(n) gives the date that corresponds with the number 
inside the parentheses (the value can be a number or a 
column name, such as [START]). The number inside the 
parentheses stands for the number of days since December 
31, 1899. For example, @DATE(1) equals '1/1/00' (that 
is, January I, 1900); @DATE(35000) equals '10/29/95: 
@DATE(n) is the complement of @NUMDATE(d). 

@DAY(d) gives the day of the month of the date inside the 
parentheses as a number. You can write the date out as 
"MM/DD/YY;' or you can use a date function, such as 

----------------------------------W7 



List Plus 

@TODAY. If you write the date out, place it inside double 
quotation marks, like this: @DAY("MM/DD/YY"). For 
example, @DAY("4/12/88'') equals 12; if the current date is 
April 1, 1988, @DAY(@TODAY) equals 1. 

@EMPTY([name]) tells you whether or not the column whose 
name is inside the parentheses is empty in the current record. 
If the column is empty, @EMPTY([name]) displays TRUE; 
it the column isn't empty, it displays FALSE. For example, 
if the current record has no city listed in the CITY column, 
@EMPTY([CITYJ) is TRUE; if there is a city listed, 
@EMPTY([CITYj) is FALSE. 

@LENGTH("text") gives the number of characters in a 
string of text. For example, @LENGTH("Boston") equals 
6. You can put the text itself inside the parentheses, or you 
can use the name of the column containing the text whose 
length you want to count, like this: @LENGTH([CITY]). If 
you put the text itself inside the parentheses, put quotation 
marks around it. 

@MAXlMUM(n, . .. ) finds the largest value among the 
values inside the parentheses (a value can be a number or 
a column name, such as [AMOUNT]). For example, 
@MAXIMUM(IO,l,S) equals 10; @MAXIMUM 
(1O,[AMOUNT],S) compares the value in the AMOUNT 
column in the current row with 10 and 5 and displays the 
largest of the three. 

@MINIMUM(n, . .. ) finds the smallest value among the 
values inside the parentheses (a value can be a number or 
a column name, such as [AMOUNT]). For example, 
@MINIMUM(10,1,S) equals 1; @MINlMUM 
(lO,[AMOUNT],S) compares the value that appears in the 
AMOUNT column in the current row with 10 and 5 and 
displays the smallest of the three. 
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@MONTH(d) gives the month of the date inside the 
parentheses as a number. You can write the date out as 
"MM/DDIYY", or you can use a date function, such as 
@TODAY. If you write the date out, place it inside 
double quotation marks, like this: @MONTH 
("MM/DD/YY"). For example, @MONTH("4/12/88") 
equals 4; if the current date is October 1, 1988, 
@MONTH(@TODAY) equals 10. 

@NUMDATE(d) gives the number that corresponds with 
the date inside the parentheses. You can write the date out 
as "MM/DD/YY", or you can use a date function, such 
as @TODAY. If you write the date out, place it inside 
double quotation marks, like this: @NUMDATE 
("MM/DD/YY"). The number @NUMDATE(d) displays 
stands for the number of days since December 31, 1899. 
For example, if the current date is June 2, 1988, 
@NUMDATE(@TODAY) equals 3229S; @NUMDATE 
("I/I/SO") equals 18263. @NUMDATE(d) is the 
complement of @DATE(n). 

@PRODUCT(n, ... ) multiplies the values you put inside the 
parentheses (a value can be a number or a column name, 
such as [AMOUNT]). For example, @PRODUCT 
([BALANCE],lO) multiplies the value in the BALANCE 
column by 10. If you use the name of a column that's empty, 
it's ignored; if the column contains a zero, however, the zero 
is not ignored. For example, if the BALANCE column is 
empty, @PRODUCT ([BALANCE],IO) equals 10. But if 
the value in the BALANCE column is zero, @PRODUCT 
([BALANCE],IO) equals zero. 

@RND(n) generates a random number between 1 and the 
value inside the parentheses (a value can be a number or a 
column name, such as [AMOUNT]). For example, 
@RND(10) equals a random number between 1 and 10. 
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@SGN(n) shows the sign of the value inside the parentheses 
(a value can be a number or a column name, such as 
[AMOUNT]). A positive sign is shown as I, a negative 
sign as -1; zero is shown as O. For example, if the value 
of [BALANCE] is - $573.38, @SGN([BALANCE]) 
equals -1. 

@SQRT(n) calculates the square root of the value inside the 
parentheses (a value can be a number or a column name, 
such as [AMOUNT]). For example, @SQRT(4) equals 2. 

@STR$(n) changes the value inside the parentheses into text 
(the value can be a number or a column name, such as 
[AMOUNT]). Changing a value into text lets you use the 
results of a formula in an alphabetic column. It also lets you 
use information you've entered in a numeric-only column in 
an alphabetic column. For example, @STR$(20) equals "20" 
(not "twenty"). Remember that even though the value 20 
and the text 20 may look the same, they're treated differently 
by List Plus. @STR$(n) is the complement of @VALUE 
(" text''). 

@SUM(n, ... ) adds together the values you put inside the 
the parentheses (a value can be a number or a column 
name, such as [AMOUNT]). @SUM([AMOUNT],lO) 
adds 10 to the value in the AMOUNT column. 

@TODAY gives the current date. For example, if the 
current date is April 1, 1988, @TODAY equals 4/1/88. 

@VALUE("text") changes the text digits inside the parentheses 
into a value. Changing text digits into a value lets you use a 
number you've entered as text in a formula or a numeric­
only column. For example, @VALUE("316") changes the 
string of characters "316" into the value 316. You can put 
the text digits themselves inside the parentheses, as in 
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@VALUE("316"); or you can use the name of the column 
that has the text you want to transform, like this: 
@VALUE([AGE]). If you put the text digits themselves 
insi<:ie the parentheses, put double quotation marks around 
the digits, like this: @VALUE("316"). @VALUE("texf') is 
the complement of @STR$(n). 

@YEAR(d) gives the year of the date inside the parentheses as 
a number. You can write the date out as "MM/DD/YY;' or 
you can use a date function, such as @TODAY. If you write 
the date out, place it inside double quotation marks, like 
this: @YEAR ("MM/DD/YY"). For example, 
@YEAR("4/12/88") equals 88; if the current date is August 
27, 1989, @YEAR(@TODAY) equals 89. The year's two 
leading digits, 19, are dropped. 

The buttons in the box give you these choices: 

OK. Click OK to accept any data entry attribute you've 
selected, any input size limit or default value you've 
entered, or any formula you've created. 

Cancel. Click Cancel to return anything you've changed to 
the way it was originally and to go back to the list. 

Set Data Display Attributes 

Use Set data display attributes to determine the format the 
information in a column appears in. The display attribute 
of a column also determines the way in which List Plus 
can manipulate the information in a column. For example, 
numbers in a column whose display format is alphanumeric 
are sorted in a different manner from numbers in a column 
whose display format is numeric. 
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To use Set data display attributes: 

• Select the column whose display format you want to set. 

• Choose Set data display attributes from the Fields menu, 
or hold down the command key and type F. 

This dialog box appears: 

Data display' For: 

@Rlphanumeric 

o Rlphobetic 0 Loltiercase 0 Uppercuse 
o ~~ljmeric 0 I~tegBr 0 Fixed [] Decimal placers) 
o Date 0 Sloshes 0 Dashes 0 Display century 
C' Phone 0 (f~tlH) Hfm t~mlfJ 0 tmN-W~~HmHfJ 
o Time 0 HH tnt (Rl!lP~I) 0 HHJ~).! (24 hours) o rlone'J' Symbol: D 
o 8efore v'llue 0 Riter value D Decimal plOCB(S) 

I~ LeI! justified o RigM justified o Centered 

~~ OK] 

These are the options you have to choose from: 

Alphanumeric. Displays the letters A through Z (both 
upper- and lowercase), the digits 0 through 9, punctuation 
marks, symbols (such as the ampersand (&), the asterisk 
(*), and so on), and spaces. (This option is automatically 
selected.) 

Alphabetic. Displays only the letters A through Z and 
spaces. 

Lowercase. Displays both upper- and lowercase letters. 

Uppercase. Displays uppercase letters only. 
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Numeric. Displays only numbers, the decimal point (.), 
the plus ( +) and minus ( - ) signs, and spaces . 

Integer. Displays only whole numbers. Rounds decimal 
numbers to the nearest whole number. 

Fixed. Displays numbers with a fixed number of 
decimal places. 

~ecimal place(s). Type the number of decimal 
places you want to be displayed. 

If a number has more decimal places than the number 
of places you set, List Plus rounds the number off. 
If the leftmost digit to be dropped is five or more, the 
number is rounded up to the next highest value. For 
example, for two decimal places, 5.005 is rounded up 
to 5.01; 5.0051 and 5.00501 are also rounded up to 5.01. 
But if the leftmost digit to be dropped is less than 5, 
the extra digits are simply dropped. So 5.004 is rounded 
down to 5.00; 5.0049 and 5.00499 are also rounded 
down to 5.00. 

Date. Displays up to six digits as a date in this format: 
MMDDIT. 

Slashes. Separates the month, day, and year with 
slashes, like this: MM/DD/YY. 

Dashes. Separates the month, day, and year with 
dashes, like this: MM-DD-YY. 

Display century. Displays all four digits of the year, like 
this: MM/DD/ITYY or MM-DD-ITYY. List Plus 
makes the first two digits of the year 19 unless you 
enter different digits. 
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Phone. Displays up to ten digits as a phone number. 

(NNN)NNN-NNNN. Displays a phone number like 
this: (800)555-4567. 

NNN-NNN-NNNN. Displays a phone number like this: 
800-555-4567. 

Time. Displays from one to four digits as time. Enter the 
time in 24-hour format. For example, for 12:00 midnight, 
type 0000 (or just one zero). 12:00 noon is 1200. 12:30AM 
is 0030 (or just 30). 1:00AM is 0100 (but not just 1 - 1 is 
the same as 0001, or 12:01 AM). 6:00AM is 0600. 6:00PM 
is 1800. 

HH:MM (AM/PM). Displays time followed by AM or 
PM to show whether it's between midnight and noon 
(AM) or between noon and midnight (PM). 

HH:MM (24 hours). Displays time in 24-hour format. 
Midnight is 00:00, noon is 12:00. 6:00 AM is 600, 
6:00 PM is 1800. 

Money. Displays a value as currency. 

Symbol: __ . Type the symbol you want to use. (A 
dollar sign is automatically displayed.) 

Before value. Displays the currency symbol before the 
value (for example, $20.00 or £20.00). 

After value. Displays the currency symbol after the 
value (for example, 95~ or 95p). 

.-Decimal place(s). Type the number of decimal 
places you want to be displayed. 
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Left justified. Starts the text or number in the cell at the 
left edge of the cell. 

Right justified. Ends the text or number in the cell at the 
right edge of the cell. 

Centered. Centers the text or number in the cell. 

The buttons in the box give you these choices: 

OK. Click OK to accept the settings you've selected. 

Cancel. Click Cancel to return the settings to the way 
they were before you made any changes and to return to 
the list. 

Records 

6R 

I!~.I(:~ 61 
','1---/----1 F',rm Z ci 2 1--t--j--r1!1 
h" F(1rm3 63 

Form 4 64 
[iMine fOrm 

" 

Select 

Use Select to extract from a list records that contain specific 
information . 
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To use Select: 

• Select the column you want to use as the basis for 
choosing records. 

• Choose Select from the Records menu, or hold down the 
command key and type R. 

This dialog box appears: 

8e18,:1 " ',,-I -----____ --.l 
[lperator : EqlJol to 

• Choose an operator. 

• Type the information you want to compare the 
information in the records to. 

List Plus compares the information you entered in the 
dialog box with the information in each cell in the column 
you've selected. 

These are the options you can choose from: 

= Equal to. Selects a record if the information in the 
column you've select matches the information in the 
dialog box exactly. 

< > Not equal to. Selects a record if the information in the 
column you've select doesn't match the information in 
the dialog box. 

> Greater than. Selects a record if the information in the 
column you've selected is greater than the information 
in the dialog box. If the information in the column is 
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alphabetic or alphanumeric, Greater than means "has a 
higher ASCII value" (see the Appendix, "ASCII 
Values:' for more information). If the information in 
the column is numeric, Greater than means "is larger 
than~' 

Examples: 

zebra is greater than ant because z has a higher ASCII 
value than a. 
1213 is greater than 19 if the format for the column is 
numeric. 
19 is greater than 1213 if the format for the column is 
alphanumeric: both Is have the same ASCII value, but 9 
has a higher ASCII value than 2. 

< Lower than. Selects a record if the information in the 
column you've selected is lower than the information in 
the dialog box. If the information in the colunm is 
alphabetic or alphanumeric, Lower than means "has a 
lower ASCII value" (see the Appendix, "ASCII Values:' 
for more information). If the information in the column 
is numeric, Lower than means "is smaller than~' 

Examples: 

ant is lower than zebra because a has a lower ASCII 
value than z. 
19 is lower than 1213 if the format for the column is 
numeric. 
1213 is lower than 19 if the format for the column is 
alphanumeric: both Is have the same ASCII value, but 2 
has a lower ASCII value than 9. 

> = Greater than or equal to. Selects a record if the 
information in the column you've selected is greater 
than or equal to the information in the dialog box. 
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If the information in the colnmn is alphabetic or 
alphanumeric, Greater than or equal to means "has 
the same or higher ASCII value" (see the Appendix, 
"ASCII Values;' for more information). If the 
information in the column is numeric, Greater than or 
equal to means "is the same as or larger than:' 

< = Lower than or equal to. Selects a record if the 
information in the column you've selected is lower 
than or equal to the information in the dialog box. 
If the information in the column is alphabetic or 
alphanumeric, Lower than or equal to means "has the 
same or a lower ACSII value" (see the Appendix, 
"ASCII Values," for more information). If the 
information in the column is numeric, Lower than or 
equal to means "is the same as or smaller than." 

B Begins with. Selects a record if the information in the 
column you've selected begins with the character or 
characters you've entered in the dialog box. 

Examples: 

tw selects two, twelve, and twenty. 
twe selects twelve and twenty. 
twen selects only twenty. 

Nil Doesn't begin with. Selects a record if the information 
in the column you've selected doesn't begin with the 
character or characters you've entered in the dialog 
box. 

Examples: 

tw selects three, but not two, twelve, or twenty. 
twe selects two, but not twelve or twenty. 
twen selects two and twelve, but not twenty. 
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IN Includes. Selects a record if the character or characters 
you've entered in the dialog box appear as part of the 
information in the column you've selected. 

Examples: 

AIC selects Deck, AIC, Sauna and jp, pool, ale but 
not FP, sauna, pool. 
Sauna selects Deck, AIC, Sauna and FP, sauna, pool 
but not jp, pool, ale. 

NI Doesn't include. Selects a record if the character or 
characters you've entered in the dialog box don't 
appear as part of the information in the column 
you've selected. 

Examples: 

pool selects Deck, Ale, Sauna but not jp, pool, ale or 
FP, sauna, pool. 
AIC selects FP, sauna, pool but not Deck, AIC, Sauna 
or jp, pool, ale. 

E Ends with. Selects a record if the information in the 
column you've selected ends with the character or 
characters you've entered in the dialog box. 

Examples: 

itis selects bronchitis and neuritis, but not agoraphobia, 
kleptomania, or monomania. 
mania selects kleptomania and monomania, but not 
agoraphobia, bronchitis, or neuritis. 

NE Doesn't end with. Selects a record if the information 
in the column you've selected doesn't end with the 
character or characters you've entered in the dialog 
box. 
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Examples: 

phobia selects bronchitis and kleptomania, but not 
agoraphobia or xenophobia. 
itis selects kleptomania, agoraphobia, and xenophobia, 
but not bronchitis. 

The buttons in the box give you these choices: 

OK. Click OK to start selecting records. 

Cancel. Click Cancel to go back to the list without 
selecting any records. 

Select More 

Use Select more to add more records from the original list 
to a list of selected records. 

To use Select more: 

• Select the column you want to use as the basis for 
choosing records. 

• Choose Select more from the Records menu. 

A dialog box appears. The dialog box is the same as the one 
that appears when you use the Select function. See the 
previous section, "Select," for an explanation of the options 
that are available. 

Select All 

Use Select all to redisplay all the records in a list after 
you've been working with just a few selected records. 

MO--------______________________ __ 

e;3 

lOW. ~3 

~·:;3 

Reference 

To use Select all: 

• Choose Select all from the Records menu, or hold down 
the command key and type T. 

The complete list reappears in the list window. 

Find 

Use Find to locate a cell whose contents match the value, 
text, date, or time you've entered i? the Fin~ dialog box. , 
Find can locate matching informatIOn only III the list that s 
active when you choose Find from the menu. 

To use Find: 

• If you don't want to search the entire list, select the cell 
where you want the search to begin. 

• Choose Find from the Records menu, or hold down the 
command key and type W. 

This dialog box appears: 

Find I~II _____________ _ 

[3J Frl)m th8 iirst cell 

o t,IQtl~h e:,:actly 

fZl On all1ields 

• Type the information you're looking for in the space next 
to Find. 
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Find doesn't distinguish between numbers that stand for a 
value and numbers that are part of text. For example, if 
you type 1200, you'll find both numeric entries like 
$1200.00 and alphanumeric entries like 1200 Mariposa 
Avenue. 

Find doesn't distinguish between uppercase and lowercase 
letters. For example, if you type chicago, you'll find 
Chicago and CHICAGO along with chicago. 

If you want to find a currency value, a date, a time, a 
phone number, or any other value that has punctuation 
other than a decimal point, a plus sign ( +), or a minus 
sign ( -), type just the value; don't type the symbol or 
~unctuation that goes along with the value. For example, 
If you want to find $1200.00, type just 1200 or 1200.00. If 
you want to find 1/07188, type just 10788. If you want to 
find 12:25 AM, type just 0025 or 25. If you want to find 
(617)-555-2964, type just 6175552964. 

These are the options you can choose: 

From the first cell. Select From the first cell if you want 
to search the entire list regardless of the record that's 
currently selected (the X in the box to the left of the 
option indicates that the option is selected). 

If you want to start the search beginning with the record 
you've selected, point to the box to the left of the option 
and click the mouse button to remove the X there. 

On all fields. Select On all fields if you want to search the 
entire list regardless of the column that's currently selected 
(the X in the box to the left of the option indicates that 
the option is selected). 

162--------------________________ __ 

~:1~ 

~. ~ 

E.·~ 

~,.~ 

I 
Er~ 
~i~ 
~i~ 
~.~ 

I 
El~ 
Ef~ 
~i~ 
~r~ 
~r~ 
~l~ 

~r'~ 
0::::.,,,. c:!l 
~I[ 
1;W';'0jJ 

.. 1= ~:'H.u,,-~ 
~] 
~--". B!j 
~'ll 
-i;:"!'~ --~ 
-]1 

.. I; •.•. ~ 
ill 

E::\"0W :~ 
~." 

Reference 

If you want to search only the column you've selected, 
point to the box to the left of the option and click the 
mouse button to remove the X there. 

Match exactly. Select Match exactly if you want to find 
only the cells that contain exactly the information you've 
entered in the space next to Find. For example, if you 
want to find just CA, and not such entries as Chicago, 
Canada, and Boca Raton, type CA and select Match 
exactly. (Find doesn't distinguish between uppercase and 
lowercase letters even when you select Match exactly.) 

The buttons give you these choices: 

Cancel. Click Cancel if you want to return to the list 
without carrying out a search. 

Find. Click Find to search for the information you've 
entered. If List Plus finds the information, the Find 
dialog box disappears, and the cell that contains the 
information is selected. If List Plus doesn't find the 
information, the Find dialog box disappears, and a 
message box saying String not found appears. 

Next 

Use Next to find the same information that you last 
searched for and found. 

To use Next: 

• If you don't want to search the entire list, and you 
canceled either From the first cell or On all fields, select 
the cell where you want the search to begin. 
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• Choose Next from the Records menu, or hold down the 
command key and type the equal sign ( =). 

List Plus immediately starts the search. If it finds the 
information, the cell that contains the information is 
selected. If it doesn't find the information, a message box 
saying String not found appears. 

Column Display 

Use Column display to change from viewing each record on 
a separate form to viewing the list in the row-and-column 
format. 

To use Column display: 

• Choose Column display from the Records menu. 

The list is redrawn iu the row-and-column format. 

Fonn 1/2/3/4 

Use Form 1 through Form" to display each record in a list 
on a separate form. You can use each Form option for a 
separate layout. (Use Define form to change the layout of 
any of the forms.) 

To use the Form option: 

• Choose the option on the Records menu that corresponds 
to the form layout you want to display, or hold down the 
command key and type the number of the Form option. 
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The list window is redrawn, and the record that's currently 
selected is displayed on a form. 

Define Fonn/Complete Form 

Use Define form to change the layout of any of the four 
forms available through the Form options. In addition to 
changing the size or location of any of the fields on the 
form, you can also add non-data text fields. (A non-~ata 
field contains text that doesn't have anything to do With any 
of the categories of information you're collecting; an example 
of a non-data field is a field for the title of a form.) 

When you choose Define form, the option on the Records 
menu changes to Complete form. 

To use Define form: 

• Choose one of the Form options to display the form you 
want to rearrange. 

• Choose Define form from the Records menu. 

The form changes so that each field is visible. 

To move a field: 

• Hold down the command key. 

• Point to the field you want to move, then press the 
mouse button and hold it down. 

A dotted outline of the field appears. 
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• Move the dotted outline to the place where you want the 
field to appear. Make sure the dotted outline doesn't 
overlap any other field. 

• Release the mouse button. 

The field disappears from its old location and appears in its 
new one. 

To hide or change the size of a field: 

• Hold down the option key. 

• Point to the field you want to hide or whose size you 
want to change, then press the mouse button and hold it 
down. 

A dotted outline of the field appears. 

• To hide the field, shrink the dotted outline to nothing by 
moving the pointer above and to the left of the upper left 
corner of the field. 

• To change the size of the field, stretch or reduce the 
dotted outline to the size you want the field to be. Make 
sure the dotted outline doesn't overlap any other field. 

• Release the mouse button. 

The field is redrawn. 

To create a non-data text field: 

• Hold down the option key. 
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• Point to any gray area on the form, hold down the 
mouse button, and drag the mouse down and to the 
right. 

A dotted rectangle appears. 

• When the field is the size you want it to be, release the 
mouse button. 

A new field appears. 

You can change the size of the field, move it, or hide it 
just like any other field. 

• When you've finished making changes to the form, 
choose Complete form from the Records menu. 

Bring Back Hidden Fields 

Use Bring back hidden fields to redisplay on a form the 
fields you've hidden. 

To use Bring back hidden fields: 

• Choose Bring back hidden fields from the Records menu. 

All the fields on the form that were hidden are redrawn, 
except for non-data fields that were empty when you hid 
them. 
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Calculate 

Total 

Use ~ot~1 to add all the values in a column together. The 
total IS .dlsplayed preceded by T in a cell below the last 
record In the column. Total recalculates the values in the 
column every time you make a change to the column. 

!otal wo~ks only with columns whose data display attribute 
IS Numenc or Money. 

To use Total: 

• Select the column you want to total. 

• Choose Total from the Calculate menu. 

The total appears in a cell below the last record in the 
column: If you total more than one column, all the totals 
appear In the same row. A check mark also appears next to 
Total on the Calculate menu. 

• To remove the total from a column, choose Total from 
the Calculate menu again. 
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The total disappears from the column, and the check mark 
that's next to Total on the Calculate menu also disappears. 

Count 

Use Count to count the number of cells in a column that 
have an entry. The count is displayed preceded by C in a 
cell below the last record in the column. The count is 
recalculated every time you make a change to a column. 

To use Count: 

• Select the column whose entries you want to count. 

• Choose Count from the Calculate menu. 

The count appears in a cell below the last record in the 
column. If you count the entries in more than one column, 
all the counts appear in the same row. A check mark also 
appears next to Count on the Calculate menu. 

• To remove the count from a column, choose Connt from 
the Calculate menu again. 

The count disappears from the column, and the check mark 
that's next to Count on the Calculate menu also disappears. 

Minimum 

Use Minimum to display the smallest value in a column. The 
minimum value is displayed preceded by n in a cell below the 
last record in the column. The minimum value is updated 
every time you make a change to the column. 
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Minimum works only with columns whose data display 
attribute is Numeric or Money. 

To use Minimnm: 

• Select the column where you want to find the lowest 
value. 

• Choose Minimum from the Calculate menu. 

The minimum value appears in a cell below the last record 
in the column. If you find the minimum value for more 
than one column, all the minimum values appear in the 
same row. A check mark also appears next to Minimum on 
the Calculate menu. 

• To remove the minimum value from a column, choose 
Minimum from the Calculate menu again. 

The minimum value disappears from the column, and the 
check mark that's next to Minimum on the Calculate menu 
also disappears. 

Maximum 

Use Maximum to find the largest value in a column. The 
maximum value is displayed preceded by S in a cell below 
the last record in the column. Maximum updates the 
maximum value in the column every time you make a 
change to the column. 

Maximum works ouly with columns whose data display 
attribute is Numeric or Money. 
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To use Maximum: 

• Select the column where you want to find the maximum 
value. 

• Choose Maximum from the Calculate menu. 

The maximum value appears in a cell below the last record 
in the column. If you find the maximum value for more 
than one column, all the maximum values appear in the 
same row. A check mark also appears next to Maximum on 
the Calculate menu. 

• To remove the maximum value from a column, choose 
Maximum from the Calculate menu again. 

The maximum value disappears from the column, and the 
check mark that's next to Maximum on the Calculate menu 
also disappears. 

Average 

Use Average to find the average of all the values in a 
column. The average is displayed preceded by A in a cell 
below the last record in the column. Average recalculates the 
average value in the column every time you make a change 
to the column. 

Average works only with columns whose data display 
attribute is Numeric or Money. 

To use Average: 

• Select the column whose average value you want to find. 
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• Choose Average from the Calculate menu. 

The average appears in a cell below the last record in the 
column. If you average more than one column all the 
averages appear in the same row. A check mark also 
appears next to Average ou the Calculate menu. 

• To remove the average from a column, choose Average 
from the Calculate menu again. 

The avera~e disappears from the column, and the check 
~ark that s next to Average on the Calculate menu also 
dIsappears. 

Sort 

Use the So~ functions to arrange all the records in a list 
accord.mg eIther to their Ascn text value or to their 
numencal value. 

What determines whether infonnation is sorted as text or as 
values is the data display attribute that you've chosen for the 
mformatJon. If you've chosen Alphanumeric or Alphabetic 
then both text and numbers are treated as text, and theY're' 
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arranged according to their ASCII value. If you've chosen 
Numeric, Date, Phone, Time, or Money, the infonnation 
is treated as numerical values. Blank fields are always last 
regardless of whether the information is being treated as text 
or numerical values. 

ASCII is a standard for assigning numerical values to the 
letters of the alphabet, numbers, punctuation marks, and 
symbols (you'll find a complete list of characters and their 
ASCII order in the Appendix). 

The ASCII order of the letters of the alphabet is the same as 
normal alphabetical order. 

Numbers and most symbols come before the letters of the 
alphabet. Say, for example, you have a list of characters 
that looks like this: 

a*9?5zMO! 

If you ordered them according to their ASCII value, the list 
would look like this: 

!*059?aMz 

ASCII treats every digit in a number separately, just as it 
treats every letter in a word separately. For example, abacus 
doesn't come after ant even though it's a bigger word than 
ant, because b, the second letter in abacus, comes before n, 
the second letter in ant. In the same way, when 1213 and 19 
are ordered according to their ASCn values, 1213 comes 
before 19 even though it's a larger number, because 2, its 
second digit, comes before 9, the second digit in 19. The 
numerical value of a number doesn't matter; it's the ASCII 
value of each of its digits taken individually that determines 
where it belongs. 
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Sort Up 

Use Sort Up to arrange text from first to last (that is, from 
lowest ASCII value to highest ASCII value), and values 
from smallest to largest. 

Sort Up arranges all the records in a list based on the 
information in a single column. 

To use Sort Up: 

• Select the column you want to use as the basis for the 
sorting. 

• Choose Sort Up from the Sort menu. 

The records in the list are rearranged according to the order 
of the information in the column you selected. 

Sort Down 

Use Sort Down to arrange text from last to first (that is, 
from highest ASCII value to lowest ASCII value), and 
values from largest to smallest. 

Sort Down arranges all the records in a list based on the 
information in a single column. 

To use Sort Down: 

• Select the column you want to use as the basis for the 
sorting. 

• Choose Sort Down from the Sort menu. 

The records in the list are rearranged according to the order 
of the information in the column you selected. 
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Reports 

Print QuickList 

Use Print QuickList to print a list in its row-and-column 
format. 

Print QnickList is different from Print. Print QnickList 
always prints a list as rows and columns regardless of 
whether a form or the row-and-column format is displayed. 
Print, on the other hand, produces a printed copy that 
matches the format that's displayed. Print QuickList also 
prints the name of the list at the top of the page and the 
page number at the bottom. Print does neither. (For more 
information, see "Print" under "File.") 

To stop printing once it has started, hold down the 
command key and type a period. 

To use Print QnickList: 

• Choose Print QnickList from the Reports menu. 
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The dialog box that appears is just like the one that appears 
when you use the Print function. See "Print" under "File" 
for complete information about the options in the dialog 
box. 

Header 

Use Header to create a header for a custom report. A 
header is text that appears at the top of every page of the 
report. 

To use Header: 

• Choose one of the Form options from the Records menu, 
or click the form box. If the list is displayed in the row­
and-column format, Header is dimmed, and you can't 
choose it. 

• Choose Header from the Reports menu. 

This dialog box appears: 

Print: 

Ddote 

D POllB numtrer 

!SItex! 
II 
fR) Print Header 

HaaOBr definition 

Justification' 

() Leit 0 Centered 0 Right 

o Left 0 Centered C' Right 

o Left @ Centered 0 Rigrl! 

@from page one 

o from poge t'110 
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These are the options you can choose: 

Print: 

date. Select date if you want the date to appear as 
part of the header. 

page number. Select page number if you want the page 
number to appear as part of the header. 

text. Select text if you want to add text to the header. 
Type the text in the space below text. 

Alignment: 

Left. Select Left if you want the date, page number, or 
text to be even with the left margin. 

Centered. Select Centered if you want the date, page 
number, or text to be evenly spaced between the left and 
right margins. 

Right. Select Right if you want the date, page number, or 
text to be even with the right margin. 

Print Header. Select Print Header if you want the header 
you've created to be printed on the report. If you don't 
want the header to be printed, click the check box next to 
Print Header to remove the X that appears there. 

from page one. Select from page one if you want the 
header to be printed on every page of the report. 

from page two. Select from page two if you want the 
header to be printed on every page of the report except the 
first one. 
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The buttons give you these choices: 

Cancel. Click Cancel to return to the list without creating 
a header. If you've made changes to a header you created 
earlier, all the changes are canceled. 

OK. Click OK when you have the header set up the way 
you want it to be. 

Footer 

Use Footer to create a footer for a custom report. A footer 
is text that appears at the bottom of every page of the 
report. 

To use Footer: 

• Choose one of the Form options from the Records menu 
or click the form box. If the list is displayed in the row- ' 
and-column format, Footer is dimmed, and you can't 
choose it. 

• Choose Footer from the Reports menu. 

The dialog box that appears is the same as the Header 
dialog box. The options you can choose from are explained 
above. 

Fields/Records 

Use Fields/Records to set up the way you want fields and 
records to appear when you print the custom report. 
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To use Fields/Records: 

• Choose one of the Form options from the Records menu, 
or click the form box. If the list is displayed in the row­
and-column format, Fields/Records is dimmed, and you 
can't choose it. 

• Choose Fields/Records from the Reports menu. 

This dialog box appears: 

fiel,jsiRecords definition 

T~p margin: [lQ] pi~BIS Bottom ffiGrgin : [JQJ pi~els 
'@One () t"lUltiple 

Field,~ : 

Space !'BII\'€en recor,j,,: 

D Drm\' line beJi.,IBBn recorDS 

These are the settings you can choose from: 

Top margin: _ pixels. Type the number of pixels you 
want to appear between the top edge of the paper and the 
first line of the first record. If you've created a header, it's 
printed within the top margin. 

Bottom margin: __ pixels. Type the number of pixels 
you want to appear between the bottom of the last record 
on a page and the bottom edge of the paper. If you've 
created a footer, it's printed within the bottom margin. 

Records per page: 

One. Select One if you want only one record printed 
on each page regardless of how short the record is. 
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Multiple. Select Multiple if you want as many complete 
records printed on a page as fit. If a record won't fit 
completely in the space that's left at the bottom of a 
page, the entire record is moved to the top of the next 
page. 

Fields: 

Fixed. Select Fixed to leave the same amount of space 
for a field every time it's printed. Fixed-length fields 
always begin and end in exactly the same place 
regardless of the length of the information in the field. 
Use Fixed if you're printing information you want to be 
aligned in columns. 

For example, if you have a form that looks like this: 

SChBdul~l 

You'd want the report to look like this: 

CLASS SCHEDULE 

9:00 AM 10 9:50 AM Cr~1iveWriting Susan Munroe 

10:00 AM 10 10:50 AM Creative Writing Susan Munroe 

11:00 AM to 11:5D AM MV.Compositio" Susan Munroe 

1:00 PM to 1:50 PM Dram. Susan MUnroe 

2:00 PM to 2:50 PM American ClaS$i~ Su,.n Munroe 

3:00 PM 10 3:50 PM Wo,ldLiteralur. Sus.n Munroe 

Ie 

E'J~ 

o 
(} 
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But if you have a form that looks like this: 

You wouldn't want the records to look like this: 

Floating. Select Floating to limit the length of a field 
each time it's printed to the length of the information 
the field contains. 

For example, an address that's printed with floating 
fields rather than fixed fields looks like this: 

Felicia Allen 
11·57 35th. SI. 3D 
Astoria, NY 11103 

Chris Sanders 
2374 Woodside In. 
Cincinnati, OH 42539 

Martin Morris 
6809 Summit Ave. 
Brookline, MA 02146 

Janis Prescott 
6373 Coddington Rd. 
Ithaca, NY 14850 

___________________________________ ~1 
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Space between records: __ pixels. Type the number of 
pixels you want between the bottom of one record and 
the top of the next. 

Draw line between records. Select Draw line between 
records if you want List Plus to draw a horizontal line 
between the bottom of one record and the top of the 
next. 

The buttons in the box give you these choices: 

Cancel. Click Cancel if you want to return to the list 
without making any changes to the setting in the 
Fields/Records dialog box. Any settings that you 
changed are returned to the way they were when the 
dialog box appeared. 

OK. Click OK when you have the settings the way you 
want them to be. 

Print Custom Report 

~ se Print Custom Report to print a report using the settings 
III the Header, Footer, and Fields/Records dialog boxes. 

Print Cnstom Report is different from Print. Print Custom 
Report lets you add headers and footers, set top and bottom 
~argins, print more than one record on a page, and choose 
fIXed or floating fields. Print lets you do none of those 
things. (For more information, see "Print" under "File.") 
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To use Print Custom Report: 

• Choose one of the Form options froiIl the Records menu, 
or click the form box. If the list is displayed in the row­
and-column format, Print Custom Report is dimmed, and 
you can't choose it. 

• Choose Print Custom Report from the Reports menu. 

The dialog box that appears is just like the one that appears 
when you use the Print function. See "Print" under "File" 
for complete information about the options in the dialog 
box. 

To stop printing once it has started, hold down the 
command key and type a period. 
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Glossary 

active window 

The window that's in front of all the others: its title bar has 
four parallel lines stretching from one end to the other. It's 
the window where you're currently working. 

Apple menu 

The menu at the far left end of the menu bar; it appears 
when you select the Apple. 

bntton 

A symbol in a dialog box that you can click to make 
something happen. To find out what a specific button does, 
see the name of the button. 

Cancel button 

The button in a dialog box that lets you leave the dialog box 
without carrying out a command. 

caps lock 

After you press the caps lock key, any letter that you type 
appears in uppercase without you having to hold the shift 
key down. Press the caps lock key, and the keyboard returns 
to normal. The caps lock key doesn't affect numbers or 
symbols. 

catalog 

The list of files that are on a disk. Catalogs appear in the 
Open and Save As dialog boxes. 
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cell 

The rectangular space where an item of information appears 
in a list. A cell is the place where a row and a column cross. 
A cell is the equivalent of a field on a form. 

change size box 

A box at the bottom-right corner of some active windows. 
Dragging the change size box changes the size of the 
window. 

character keys 

Character keys repeal when you hold them down. The 
character keys are: letters, numbers, symbols, punctuation, 
return, tab, and the spacebar. 

check box 

The small box or circle next to an option in a dialog box 
that you click to select or cancel an option. 

choose 

To pick a command from a menu. 

click 

To position the pointer on something and then press and 
quickly release the button on the mouse. 

Clipboard 

The place where information you've cut or copied is placed. 
The information stays on the Clipboard even after you've 
pasted it elsewhere in the document until you cut or copy 
another section of information. 

close 

To remove a window from the screen. 

186--------------------------------
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close box 

The small square on the left side of the title bar of an active 
window. Click it to close the window. 

column 

The part of a list that runs from top to bottom. A column 
contains information that's all the same type (for example, 
names or addresses or phone numbers). The name of a 
column in a list appears as the name of a field on a form. 

command 

A command is a choice you make from a menu that causes 
some action to take place, or a combination of the 
command key and a letter on the keyboard that causes the 
same action. 

command key 

A key that, when held down while another key is pressed, 
causes a command to take effect, or when held down, lets 
you drag a window to a new location without activating it. 

constant 

A value or set of characters that stays the same each time a 
formula is calculated. 

cursor 

A blinking vertical bar that marks the spot in a list where 
something will be added or removed. The cursor is also 
found in some dialog boxes. 

cut 

To remove information from a list by selecting it and then 
choosing Cut from the Edit menu. The information you cut 
is placed on the Clipboard. See also Clipboard. 
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delete 

The key that moves the cursor backwards, erasing the 
character that's to the left of it. 

desktop 

The working environment - the menu bar and the grey 
area on the screen. 

dialog box 

A box with a message that asks you for a decision or for 
more information. Sometimes the message informs you that 
you can't do what you're trying to do or warns you that 
what you're about to do will destroy some information. 

dimmed 

A dimmed command, menu title, or option is one that 
appears gray rather than black. It means that you can't use 
the item. 

double-click 

To position the pointer on something and then quickly press 
and release the mouse button twice. 

drag 

To position the pointer on something and hold down the 
mouse button while you move the mouse. You release the 
mouse button to choose a menu item or to select 
information. 

enter 

A key that confirms or ends an entry or sometimes a 
command. N Ole: If you're using an Apple II that has been 
upgraded to an Apple HGS, there's no enter key. 
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field 

The space where an individual item of information appears 
on a form. 

Finder 

A program that gives you access to the entire Apple IIGS 
system. The Finder displays all the parts of the system as 
icons on a desktop. To start an application, you double-click 
the icon that represents it. 

folder 

A file you create where you can keep together lists that are 
related (for example, a list and several smaller lists derived 
from it). 

font 

A complete collection of letters, numbers, punctuation 
marks, and other symbols with a characteristic appearance. 
The font List Plus uses is Shaston. 

footer 

The bottom margin of a report, which is repeated on every 
page. It can include text, page numbers, the date, and the 
time. 

form 

A way of arranging information from a list so that each 
record is displayed separately (rather than in the row-and­
column format of a list). Each cell in the list appears as the 
name of one of those fields. 

form box 

The box just above the vertical scroll bar that you can use 
to switch between viewing a list organized in rows and 
columns and viewing each record on a single form . 
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full size box 

A box at the right edge of a list's title bar that gives you a 
full screen view of the list when you click it. Clicking it a 
second time returns you to the standard desktop view. 

header 

The top margin of a report, which is repeated on every 
page. It can include text, page numbers, the date, and the 
time. 

highlight 

To change the color of a background to make something 
stand out from the rest of a document. Highlighting usually 
shows that something has been selected or chosen. 

icon 

A simple small picture that represents an object (such as a 
folder or a diskette). 

lauucher 

The program that gives you access to the entire Apple nos 
system. The launcher shows you a list of the files on the 
disk that's iu the disk drive and lets you choose the one you 
want to start. See also Finder. 

list 

A collection of information organized in rows and columns. 

list window 

A window that displays a list. 

~o--------------------------------
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logical value 

TRUE or FALSE. A logical value indicates whether the 
statement made by a formula is true or false for a specific 
set of numbers, characters, or other logical values. 

memory 

The place in the computer's main unit that stores 
information while you're working on it. 

menu 

A list of commands that appears when you point to and 
press a menu title in the menu bar. Dragging through the 
menu and releasing the mouse button while a command is 
highlighted chooses that command. 

menu bar 

The horizontal strip at the top of the screen that contains 
menu titles. 

menu title 

A word or phrase in the menu bar that designates one 
menu. Pressing on the menu title causes the title to be 
highlighted and its menu to appear below it. 

open 

To retrieve a list you've saved on a disk. 

option 

A key used like the shift key to give you an alternate 
interpretation to another key you type. 

paste 

To place the contents of the Clipboard - whatever was last 
cut or copied - in the cell you've selected or at the place 
marked by the cursor. ________________________________ ~1 
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pointer 

A small arrow on the screen that follows the movement of 
the mouse. 

press 

To position the pointer on something and then hold down 
the mouse button without moving the mouse. In reference 
to keys, it means to strike the key lightly, holding it down 
only if you want to repeat a character. 

record 

The items of information grouped together in a single row 
in a list. 

relational operator 

An operator that lets you compare two separate pieces of 
information. 

report 

A printed list of all or some of the information in a list. 

return 

A key that moves the highlight to the first cell in the next 
row. It's also used in some cases to confirm or terminate a 
command or an entry. 

row 

The part of a list that runs from side to side. A row 
contains one item of information of each type (for example, 
a single name, address, and phone number that all belong to 
the same person). All the items in a row appear together on 
a single form, each in its own field. 

save 

To store information on a disk. 
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scroll 

To move a list or directory in its window so that a different 
part of it is visible. You can also scroll the directory in the 
Open dialog box. 

scroll arrow 

An arrow on either end of the scroll bar. Clicking a scroll 
arrow moves the list or directory one line. Pressing a scroll 
arrow scrolls continuously. 

scroll bar 

A rectangular bar that may be along the right or bottom of 
an active window. Clicking or dragging in the scroll bar 
causes the view of the list or directory to change. 

scroll box 

The white box in the scroll bar. The position in the scroll 
bar indicates the position of what's in the window relative to 
the entire list. 

select 

To designate where the next action will take place. You use 
the mouse techniques of clicking, double-clicking, and 
dragging to select something. 

shift 

The key you press to type letters in uppercase and that 
causes the upper symbol to appear when you press a number 
or symbol key. 
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shift-click 

A technique that lets you extend or shorten selected text: 
you position the pointer at the end of the text you want to 
select, then hold down the shift key and click the mouse 
button. 

sort 

To arrange all the records (or rows) in a list in order. 

spacebar 

The long, unlabeled bar on the keyboard that you press to 
type a space. 

tab key 

The key you press when you've finished entering 
information in a cell to move to the next cell to the right. 
You also use the tab key to move to the next space when 
you're entering information in a dialog box with more than 
one space for information. 

title bar 

The horizontal bar at the top of a window that shows the 
name of the window's contents and lets you move the 
window. 

window 

The area that displays information on the desktop. You view 
a list through a window. You can open or close a window, 
move it around on the desktop, and sometimes change its 
size, scroll through it, and edit its contents. 
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Appendix 

ASCII Values 

33 ! 56 8 790 
34 " 57 9 80 P 
35 # 58 : 81 Q 
36 $ 59 ; 82 R 
37 0/0 60 < 83 S 
38 & 61 = 84 T 
39 ' (apostrophe) 62 > 85 U 
40 ( 63 ? 86 V 
41 ) 64 @ 87 W 
42 * 65 A 88 X 
43 + 66 B 89 Y 
44 ,(comma) 67 C 90 Z 
45 - (hyphen) 68 D 91 [ 
46 . 69 E 92 \ 
47 / 70 F 93 1 
48 0 (zero) 7lG 94 A 

49 1 72H 95 _ (underscore) 
50 2 73 I 96 ' (grave accent) 
51 3 74 J 123 { 
52 4 75 K 124 I 
53 5 76 L 125 J 
54 6 77M 126 N 

55 7 78 N 

N ole: The lowercase letters of the alphabet are assigned in 
ASCII to the numbers 97 through 122. List Plus doesn't 
distinguish between uppercase and lowercase letters, so all 
letters are treated as if they're uppercase. 
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Index 

adding column(s), 51, 132 
Apple menu, 16, 105 
AppleTalk, 43, ll3-116 
ASCII values, 70, 195 
attributes, entry, 

alphabetic, 45, 139 
alphanumeric, 45, 138 
digits, 45, 139 
duplicating, 48-50 
numeric, 45, 139 

Average function, 64, 171-172 
backup disk, 3-5 

Calculate menu, 17,62, 168-172 
calculation functions, 61-64 
Cancel button, 33 
catalog, 24 
cells, 

active, 26 
entering information, 26-27 
inactive, 26 

cell contents, 
changing information, 29 
copying, 59 
cutting, 58, 126-127 
pasting, 60 
replacing, 31 
selecting, 25 
shifting, 83-84, 129-130 
transferring, 81-82 
undoing, 30-31 

change size box, 21-22, 104 
changing, 

column width, 43-44 
format, 85-90 

Choose Printer command, 38, 113-116 
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List Plus 

Clipboard, 58 
erasing, 60 

Close command, 35, 109 
close box, 21, 103 
closing list window, 35 
column(s), 28 

adding, 51, 132 
changing width, 43-44 
copying between, 49, 81-82, 136-137 
deleting, 53, 133-134 
duplicating, 49-50, 81-82, 135-137 
formatting, 47 
inserting, 51-52, 132-133 
moving, 54-55, 134-135 
naming, 42 
selecting, 26 
transferring, 81-82, 136-137 

command key, 7 
comparing, see: relational operators 
Copy option, 59, 127 
Count function, 62, 169 
Cut option, 58, 126-127 

data entry window, 18 
data display attributes, 

setting, 47, 151-155 
dates, 

displaying, 105 
formatting, 48 
entering, 44 

desktop, 15, 107 
dialog box, 18 
difference formula, 65-67 
directory, see: catalog 
displaying numbers, 27 
Duplicate column option, 48-50, 135-136 

Edit menu, 16, 30, 126-131 
editing, 

cell contents, 29-31, 126-131 
erasing disk, 32 
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fields, 
enlarging, 87-88 
fIXed-length, 93-94, 180 
floating, 94, 181-182 
hiding, 86-87, 166 
moving, 88-89, 165-166 
non-data, 90, 166-167 
shrinking, 87-88 

Fields menu, 16, 45-55, 132-155 
Fields/Records option, 92, 178-179 
File menu, 16, 106-107 
Find command, 161-162 
Finder, 12-15 
footer(s), 95, 97 
form box, 21, 104 
format, 

changing, 85-90 
saving, 111 

formatting, 
column(s), 47 
dates, 48 

formulas, 64-65, 139-151 
difference, 65-67 
money due, 67-68 

full size box, 21, 103 

header(s), 95-96, 176 
printing, 96, 177 

ImageWriter, 117-119, 123-124 

keyboard, 22 

labels, 
printing, 93, 94, 98 

LaserWriter, 119-121, 124-125 
launcher, 10-11 
list window, 18, 101 

manipulating, 20-21 

Index 
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List Plus 

making a backup copy, 3-5 
margin(s), 92, 179 
Maximum function, 63-64, 170-171 
menu, 

Apple, 16, 105 
Calculate, 17, 62, 168-172 
Edit, 16, 30, 126-131 
Fields, 16, 132-150 
File, 16, 106-107 
Records, 17,72, 155-167 
Reports, 17, 175-183 
Sort, 17, 71, 172-174 

menu bar, 16 
message box, 19 
Minimum function, 63, 169-170 
money, 154 
money due formula, 67-68 
mouse, 7 
moving columns, 54-55, 134-135 

naming a column, 42 
New command, 41, 107 
numbers, 

variety of display, 27 

Open command, 108-109 
opening a list, 23 
Operators, relational, 

begins with, 76-77 
doesn't begin with, 76-77 
doesn't end with, 78 
doesn't include, 77-78 
ends with, 78 
equal to, 74 
greater than, 75 
includes, 77-78 
lower than, 76 
not equal to, 74 

organizing information, 
first to last, 36 
small to large, 36 
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page numbers, 96 
Page SetUp command, 116, 121 
Paste command, 60, 128 
Print command, 122, 125 
Print Custom Report command, 182-183 
Print QuickList command, 38, 122, 175-176 
printer, see: AppleTalk, ImageWriter, LaserWriter 
printing, 37-39, 113-116 

address list, 97 
columns, 94 
labels, 93, 94, 98 
records per page, 93 

Quit command, 125-126 
quitting List Plus, 22 

record, 29 
records, 

number per page, 93 
space between, 92 

Records menu, 17, 72, 155-167 
relational operators, 73-78 
removing list from screen, see: close box 
replacing cell contents, 31 
reports, 

summary, 85 
custom, 85, 97 
printing, 122, 182-183 

Reports menu, 17, 175-183 
Revert command, 112-113 
rows, 29 

activating, 26 
creating, 56 
deleting, 57, 130-131 
duplicating, 56-57, 131 
inserting, 56, 130 

Save command, 32, 109-111 
Save As command, 32-33, 112 

canceling, 33 

Index 
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Index 

saving work to disk, 34,111 
scroll bar, 20, 21 

horizontal, 21, 102 
vertical, 21, 102 

Select function, 72-73, 78-81, 155-160 
selecting, 

range of values, 79 
Shift function, 83-84, 129-130 
Sort menu, 17,71, 172-174 
Sort Up option, 36, 71, 174 
Sort Down option, 36, 71, 174 
sorting, 36-37 

by ASCII value, 69 
by numerical value, 69 
combined with selecting, 75-76 
text, 69 

starting List Plus, 9-15 

time, 154 
Total function, 63, 168-169 
transferring between lists, 81-82 

Undo command, 30, 126 

Values, 
average, 64, 171-172 
maximum, 63-64, 170-171 
minimum, 63, 169-170 

window(s), 17 
changing size, 104 
clock, 105-106 
closing, 35-36 
data entry, 18 
list, 18, 20, 101 
manipulating, 20-21 
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Activision Software 
Limited Warranty: Limitation on Liability 

Activision, Inc. makes the following warranties: 

(a) This software product will perform substantially in accordance with the documentation supplied with it. If, 
within ninety (90) days after your purchase, the product fails to do so, Activision shall use its best efforts to 
replace the defective diskette or document which corrects such failure. If such replacement is not feasible or 
does not resolve the failure, Activision may, at its option, refund your purchase price upon receipt of the 
original product with all documentation and proof of purchase, which shall constitute your sole and ex· 
elusive remedy in the event of such failure. 

(b) The mediwn on which this software product is recorded will be free from defects in material and faulty 
workmanship under normal use and service for a period of ninety (90) days from the date of purchase. If 
during this period you fmd a defect in the medium, it should be returned to Activision at the address noted 
below, postage prepaid, with proof of date of purchase. Your sale and exclusive remedy in the event of such 
a defect is expressly limited to replacement of the medium as provided for herein. 

If the recording medium should fail after the original ninety (90) day warranty period has expired, you may 
return the software program to Activision at the address noted below with a check or money order for $10.00 
(U.S. currency), which includes postage and handling, and Activision will mail a replacement to you. To 
receive a replacement, you should enclose the defective medium (including the original product label) in pro­
tective packaging accompanied by: (I) a $10.00 check, (2) a brief statement describing the defect, and (3) 
your return address. 

Actimion dOeS not warrant that this product will meet your requirements or that the operation of the product 
will be uninterrupted or errOr free. You assume responsibility for the selection of the program to achieve your in­
tended results and for the installation, use and results obtained from the program. The foregoing warranties do 
not apply if yOIl mishandle, alter or improperly copy, use or store the diskette and/or the documentation. 
Although changes or improvements to the software, diskette and/or documentation may be made, Activision 
will be under no obligation to provide them to you. This product should be used only with tlie computers, disk 
drives, print~s and other components specified in the accompanying documentation. Activision is not responsi­
ble for problems caused by changes to computers or other components which are made after the initial release of 
this product. 

EXCEPT AS SET FORTH ABOVE, TIDS WARRANTY IS IN LIEU OF ALL OTHER WARRANTIES, 
WHETHER ORAL OR WRITTEN, EXPRESS OR IMPLIED, INCLUDING ANY WARRANTY OF MER· 
CHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE, AND NO OTHER REPRESENTATIONS 
OR CLAIMS OF ANY NATURE SHALL BE BINDING ON OR OBLIGATE ACTIVISION. IN NO EVENT 
WILL ACTIVISION BE LIABLE FOR SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES 
RESULTING FROM POSSESSION, USE OR MALFUNCTION OF THIS PRODUcr, INCLUDING 
DAMAGElOPROPERTYAND,lOTHEEXTENTPEQMnTTEDBYLAW, DAMAGES FOR PERSONAL 
INJURY, EVEN IF ACTIVISION HAS BEEN ADVISED OF THE POSSmILITY OF SUCH DAMAGES. 

No action for any breach of the above warranties may be commenced more than one (1) year following the ex­
piration date of the applicable warranty. 

som STATES DO Nor ALLOW LIMITATIONS ON HOW LONG AN IMPLIED WARRANTY LASTS 
AND/OR THE EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, 
SO THE ABOVE LIMITATIONS AND/OR EXCLUSION OR LIMITATION OF LIABILITY MAY Nor AP· 
PLY TO YOU. THIS WARRANTY GIVF.s YOU SPEcmC LEGAL RIGlITS, AND YOU MAY HAVE 
OTHER RIGHTS WIllCH VARY FROM STATE TO STATE. 

RETURNS 
U.P.S. or registered mall is recommended for returns. For the best service, please be sure to-

L Send the diskette and sales receipt. 

2. Write the name of the product and the type of computer system you have on the front of the package. 

3. Enclose your return address, typed or printed clearly, inside the package. 

Send to: 

WARRANTY REPLACEMENTS 
Product Support 
Activision, Inc. 

2350 Bayshore Parkway 
Mountain View, CA 94043 


